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Safety Guidelines
This manual contains notices you have to observe in order to ensure your 
personal safety, as well as to prevent damage to property. The notices referring to 
your personal safety are highlighted in the manual by a safety alert symbol, 
notices referring to property damage only have no safety alert symbol. The 
notices shown below are graded according to the degree of danger.

If more than one degree of danger is present, the warning notice representing the 
highest degree of danger will be used. A notice warning of injury to persons with 
a safety alert symbol may also include a warning relating to property damage.

Danger
indicates that death or severe personal injury will result if proper precautions 
are not taken.

Warning
indicates that death or severe personal injury may result if proper precautions 
are not taken.

Caution
with a safety alert symbol indicates that minor personal injury can result if 
proper precautions are not taken.

Caution
without a safety alert symbol indicates that property damage can result if 
proper precautions are not taken.

Notice
indicates that an unintended result or situation can occur if the corresponding 
notice is not taken into account.



Qualified Personnel
The device/system may only be set up and used in conjunction with this 
documentation. Commissioning and operation of a device/system may only be 
performed by qualified personnel. Within the context of the safety notices in 
this documentation qualified persons are defined as persons who are authorized 
to commission, ground and label devices, systems and circuits in accordance with 
established safety practices and standards.

Prescribed Usage
Note the following:

Trademarks
All names identified by ® are registered trademarks of the Siemens AG.

The remaining trademarks in this publication may be trademarks whose use by 
third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the 
hardware and software described. Since variance cannot be precluded entirely, 
we cannot guarantee full consistency. However, the information in this 
publication is reviewed regularly and any necessary corrections are included in 
subsequent editions.

Siemens AG
Automation and Drives
Postfach 4848
90437 NÜRNBERG
GERMANY

12/2006

Copyright © Siemens AG 2006 
Technical data subject to change

Warning
This device and its components may only be used for the applications 
described in the catalog or the technical description, and only in connection 
with devices or components from other manufacturers which have been 
approved or recommended by Siemens. Correct, reliable operation of the 
product requires proper transport, storage, positioning and assembly as well as 
careful operation and maintenance.
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Preface
PREFACE Welcome!

Purpose of This Manual
This manual describes remote commands and ReadRunner remote libraries.

Further Support
If you have any questions concerning the use of products which are not answered 
in this manual, please contact your local Siemens partner at your Siemens office.

You can find your local partner at:

http://www.siemens.com/automation/partner

You can find a guide to the technical documentation on offer for the individual 
SIMATIC products and systems at:

http://www.siemens.de/simatic-tech-doku-portal

You can find the catalog and online ordering systems at:

http://mall.automation.siemens.com/
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Preface
Training Center

SITRAIN™ Siemens Training
Siemens Training (SITRAIN) offers a range of courses on Machine Vision and 
Symbology Reading. Training classes are conducted in Norcross, Georgia and at 
locations across the USA. SITRAIN also offers courses on PLC, Drives, 
Controls, HMI, NET, Process Control, Analyzers and Instrumentation, Electrical 
and Power, Safety and more. Details of current SITRAIN course offerings can be 
viewed at http://www.automation.usa.siemens.com/sitrain/

To view Machine Vision and Symbology course offerings, please click on the 
“Automation” link in the middle of the page and then the “Vision and Sensors” 
link from the list that is presented. Alternatively, please contact the Siemens 
Training Registrar at (800) 241-4453. 

Technical Support
How to reach technical support for all A&D products

• With the Support Request form on the Web:
http://www.siemens.de/automation/support-request

• Telephone: + 49 180 5050 222

• Telephone: 800 333-7421 (USA)

• Fax: + 49 180 5050 223

Further information about our technical support is available in the Internet at 
http://www.siemens.com/automation/service
xiv HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006



Service & Support on the Internet
The Siemens Service & Support team provides you with comprehensive 
additional information on SIMATIC products in its online Internet services.

http://www.siemens.com/automation/service&support

There you can find:

• Current product information and downloads which you may find useful for 
your product.

• The documents you require, using our Service & Support search engine.

• A forum where users and experts from all over the world exchange ideas.

• Your local partner for Automation & Drives.

• Information about onsite services, repairs, spare parts. Lots more is available 
to you on our “Service“ pages.

Manual Conventions
The following typographical conventions are used throughout this manual.

• Items emphasizing important information is bolded.

• Menu selections, menu items and entries in screen images are indicated as: 
Run (triggered), Modify..., etc.

Indicates Class II laser radiation.
Rev 2.2.1, Jul. 2006 HawkEye 1500 Series Reference & Programmers Manual xv



Preface
Related Documentation

• HawkEye™ 1500 Series Quick Start Guide — Contains step by step 
procedural information to set up the Siemens HawkEye™ 1500.

• HawkEye™ 1500 Series User Manual — Contains information about the 
HawkEye™ 1500 Graphical User Interface, how to upgrade camera 
software, troubleshooting information, frequently asked questions, and 
sample Data Matrix symbols and barcodes.

• HawkEye™ 1500 Series Verification Manual — Contains detailed 
information about the DPM verification configuration available on 
HawkEye™ 1500 Series Smart Camera Readers.
xvi HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006



1

R
em

o
te

 C
o

m
m

an
d

s 
R

ef
er

en
ce

1

CHAPTER 1 Remote Commands Reference

This chapter lists and describes the HawkEye™ 1500 remote commands. 
Commands are listed alphabetically.

Basic Operation & Fine Tuning
This section describes the basic operations and fine-tuning used with the 
HawkEye™ 1500.

Command Basics
The HawkEye™ 1500 responds to a series of ASCII string commands sent from 
the host computer over RS-232 and Ethernet ports. Each command must follow 
the designated command syntax for the camera to respond successfully.

The command sequence consists of the command word(s) followed by any 
additional keyword or parameters required, and terminated with a carriage return 
<CR> or <Enter>. 

There are two types of commands:

• Action commands cause an action to take place. They have no settings that 
can be queried by the user.

For example, the SAVE command is an action command that initiates the 
action of saving system parameters to the FLASH storage system on the 
camera. There is nothing to query about SAVE.
Rev 2.2.1, Jul. 2006 HawkEye 1500 Series Reference & Programmers Manual 1-1



Chapter 1 Remote Commands Reference
• Configuration commands “set” a parameter or “query” the contents of a 
parameter.

For example, the ROWS command sets the number of rows to a specific 
number.

All configuration commands follow the same syntax and format:

• A configuration command followed by a “?” means query the current value 
(return to the user the current value of the configuration command).

For example:

ROWS ?

Would result in the following:

ROWS AUTO (or whatever the current value is at that time)

• A configuration command followed by a blank (no parameter) means show 
the user a quick 'help' on the command syntax.

For example:

ROWS <ENTER>

Would result in the following:

ROWS {rows|AUTO} — Set the number of rows to expected: 
8-144, AUTO=DFLT

• A configuration command followed by 'DEF[AULT]' means set the current 
value of the command to its default value. The default value being the value 
that was initially set from the Factory Default configuration.

For example:

ROWS DEF[AULT]

Would result in the current value of ROWS to be set to its default value of 
AUTO.

To get help on a particular Action command, you would issue the word “HELP” 
followed by the command of interest. 

For example:
1-2 HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006
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HELP RESET

Would result in the following:

RESET [opt] - Reset the unit - Reset user settings type Help Reset v[erbose]

If more detailed help information is desired (and available), issue:

HELP RESET V[erbose] 

Which would result in printing more verbose help information.

RESET [opt] - Reset the unit - Reset user settings type Help Reset v[erbose]

RESET FACTORY - Reset all settings to factory defaults. This includes all 
connectivity options. The camera will be set to DHCP Y, camera name 
'HawkEye', default IP address, CONSOLE 0, BEEP Y. Essentially, all 
decoder parameters, acquisition parameters, and BOOTPARAMS stuff 
(except for the MAC address) would be reset to factory defaults. All would 
be saved to flash.

RESET DECODER - This would be the same as LOAD 99 and would reset 
the decoder (only) to defaults. Photometry would also be reset to Auto. This 
would save to flash, whereas LOAD 99 would not.

RESET APPMODE - This would reset the acquisition parameters and 
lighting (essentially everything in the Application Mode dialog of RR. This 
would save to flash.

RESET HARD - This reboots the unit.

RESET SOFT - This goes offline, restores the registry to factory default, and 
goes back online.

RESET ALL - This does a 'reset factory', saves to flash, and 'reset hard'.

For the most part, commands are NOT case sensitive. When entering strings (as 
required by a particular command), the string must be entered in quotes. 
Characters in quotes are case sensitive. You get what you type.

Getting Help on a Particular Command
If you are not using ReadRunner to control the camera, or, if you are and wish to 
command the camera via the Command Terminal Window, the following 
describes the available options:
Rev 2.2.1, Jul. 2006 HawkEye 1500 Series Reference & Programmers Manual 1-3



Chapter 1 Remote Commands Reference
HELP <ENTER> 

Displays a listing of all the available commands divided into eight categories.

Once you see the command that is most likely the one of interest, you can get 
quick help by typing:

HELP {command}

or verbose help on the command by typing:

HELP {command} V[erbose]

Additionally, you can get help on configuration commands by typing the 
command with no parameter information provided.

For example:

HELP ROWS <ENTER>

Would result in the following:

ROWS {rows|AUTO} - Set the number of rows to expected: 
8-144, AUTO=DFLT
1-4 HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006
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Remote Commands
Table 1–1 through Table 1–8 group commands based on function.

TABLE 1–1. Housekeeping Query Commands

Command Page

HELP “HELP” on page 1-59

QUICSET “QUICSET” on page 1-125

SHOW “SHOW” on page 1-147

STATS “STATS” on page 1-149

VERSION “VERSION” on page 1-175

TABLE 1–2. System Operation Control Commands

Command Page

CAPTURE “CAPTURE” on page 1-34

CONTROL “CONTROL” on page 1-40

OFFLINE “OFFLINE” on page 1-92

ONLINE “ONLINE” on page 1-97

RELEASE “RELEASE” on page 1-129

RESET “RESET” on page 1-133

SAVE “SAVE” on page 1-143

VT “VT” on page 1-178

TABLE 1–3. Serial Reporting Configuration Commands

Command Page

DECFL “DECFL” on page 1-41

HEADER “HEADER” on page 1-57

IOASSIGN “IOASSIGN” on page 1-64

LOCFL “LOCFL” on page 1-72

MATCHFL “MATCHFL” on page 1-82

OKDEC “OKDEC” on page 1-93

OKMATCH “OKMATCH” on page 1-95

OUTPUT FORMAT “OUTPUT” on page 1-99
Rev 2.2.1, Jul. 2006 HawkEye 1500 Series Reference & Programmers Manual 1-5



Chapter 1 Remote Commands Reference
RTE “RTE” on page 1-140

SET CRITERIA “SET_CRITERIA” on page 1-144

TRAILER “TRAILER” on page 1-161

VERIFY “VERIFY” on page 1-172

TABLE 1–4. System Configuration Commands

Command Page

DWELLTIME “DWELLTIME” on page 1-50

ILLUMINATION “ILLUMINATION” on page 1-60

IO_MODE “IO_MODE” on page 1-63

MATCHCOUNT “MATCHCOUNT” on page 1-79

MATCHEX “MATCHEX” on page 1-80

MATCHSERIAL “MATCHSERIAL” on page 1-84

MATCHSTRING “MATCHSTRING” on page 1-85

PHOTOMETRY “PHOTOMETRY” on page 1-115

QUICSETPLUS “QUICSETPLUS” on page 1-127

RETRY “RETRY” on page 1-134

SIGOUT “SIGOUT” on page 1-148

TARGET “TARGET” on page 1-152

TBL “TBL” on page 1-153

TD “TD” on page 1-154

TE “TE” on page 1-155

TRIG “TRIG{GER}” on page 1-163

TRIGTABLE “TRIGTABLE” on page 1-164

TABLE 1–3. Serial Reporting Configuration Commands (Continued)

Command Page
1-6 HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006
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TABLE 1–5. Communication Control Related Commands

Command Page

DHCP “DHCP” on page 1-43

DOMAIN “DOMAIN” on page 1-49

EIPENABLE “EIPENABLE” on page 1-52

INFORM “INFORM” on page 1-61

IP “IP” on page 1-66

IPCONFIG “IPCONFIG” on page 1-67

PROMPT “PROMPT” on page 1-123

TERMINAL ECHO “TERMINAL ECHO” on page 1-156

TTY “TTY” on page 1-167

TABLE 1–6. Decoder Configuration Commands (PID Info)

Command Page

BARCODE “BARCODE” on page 1-14

BARCODE ENABLEMASK “BARCODE ENABLEMASK” on page 1-15

BARCONF “BARCONF” on page 1-17

BARHGT “BARHGT” on page 1-18

BARHPS “BARHPS” on page 1-19

BARLEN “BARLEN” on page 1-20

BARNUM “BARNUM” on page 1-21

BARPRB “BARPRB” on page 1-22

BARQZ “BARQZ” on page 1-23

BARTHRES “BARTHRES” on page 1-24

BARVPS “BARVPS” on page 1-25

BARWDT “BARWDT” on page 1-26

CELL SAMPLE “CELL SAMPLE” on page 1-35

CELL SIZE “CELL SIZE” on page 1-36

COLS “COLS” on page 1-37

CONTRAST “CONTRAST” on page 1-39

ECC “ECC” on page 1-51

ENSURE “ENSURE CENTERED” on page 1-53
Rev 2.2.1, Jul. 2006 HawkEye 1500 Series Reference & Programmers Manual 1-7
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HEIGHT “HEIGHT” on page 1-58

MATCHCOUNT “MATCHCOUNT” on page 1-79

MATCHSERIAL “MATCHSERIAL” on page 1-84

MATCHSTRING “MATCHSTRING” on page 1-85

MORPHOLOGY “MORPHOLOGY” on page 1-86

NUMBC “NUMBC” on page 1-90

NUMDM “NUMDM” on page 1-91

ORIENT “ORIENT” on page 1-98

POLARITY “POLARITY” on page 1-118

PROBE “PROBE DIRECTION” on page 1-120

RATIO “RATIO” on page 1-128

ROI “ROI” on page 1-138

ROWS “ROWS” on page 1-139

STYLE “STYLE” on page 1-151

THRES “THRESHOLD” on page 1-157

TIMEOUT “TIMEOUT” on page 1-159

WARP “WARP” on page 1-179

WIDTH “WIDTH” on page 1-180

TABLE 1–7. Product Identification (PID) Control Configuration Commands

Command Page

ASSIGN “ASSIGN” on page 1-12

ASSIGNEX “ASSIGNEX” on page 1-13

DELETE “DELETE” on page 1-42

LEARN “LEARN” on page 1-68

LEARNASSIST “LEARNASSIST” on page 1-69

LEARNCANCEL “LEARNCANCEL” on page 1-70

LOAD “LOAD” on page 1-71

PID “PID” on page 1-116

TABLE 1–6. Decoder Configuration Commands (PID Info) (Continued)

Command Page
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Command Conventions
The following conventions apply to remote command descriptions:

• { } — Indicates that the information is required.

• [ ] — Indicates that the information is optional.

REMOVE “REMOVE” on page 1-130

STORE “STORE” on page 1-150

UNLEARN “UNLEARN” on page 1-168

VIEW “VIEW” on page 1-177

TABLE 1–8. Part Queue Configuration/Control Commands

Command Page

PARTQ “PARTQ” on page 1-101

PARTQCAPACITY “PARTQCAPACITY” on page 1-102

PARTQCLEAR “PARTQCLEAR” on page 1-103

PARTQCOUNT “PARTQCOUNT” on page 1-104

PARTQFAIL “PARTQFAIL” on page 1-105

PARTQFTP “PARTQFTP” on page 1-106

PARTQFTPEX “PARTQFTPEX” on page 1-108

PARTQREQ “PARTQREQ” on page 1-109

PARTQREQFORMAT “PARTQREQFORMAT” on page 1-110

PARTQSAVE “PARTQSAVE” on page 1-112

PARTQSUM “PARTQSUM” on page 1-113

TABLE 1–7. Product Identification (PID) Control Configuration Commands 
(Continued)

Command Page
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Terminal Shortcuts

TABLE 1–9. Terminal Shortcuts

Shortcut What It Does

Ctrl+O Turn off report output.

Ctrl+P Toggle the state of the prompt and echo.

Ctrl+Q Turn off command output.

Ctrl+R Release control of the unit and put it back online.

Ctrl+S Take control of the unit and bring it offline (forcibly).

Ctrl+T Dump the heartbeat string to the terminal.

Ctrl+U Toggle the display of report strings on the terminal.

Ctrl+W Turn on command output.
1-10 HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006
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Keyword Output Conditions
Table 1–10 lists the valid keywords for the listed commands.

Note: You must have a verification license for VERI_1_IAQG and 
VERI_STATUS.

TABLE 1–10. Keyword Output Conditions

Local Permutations

A
N
G
L
E

C
H
E
C
K
S
U
M

D
A
T
A

D
A
T
A
H
E
X

D
E
T
A
I
L
E
D

P
I
D
#

T
I
M
E
S
T
A
M
P

V
E
R
I
_
1
_
I
A
Q
G
*

V
E
R
I
_
D
E
T
A
I
L

V
E
R
I
_
F
O
R
M
A
T
T
E
D

V
E
R
I
_
G
R
A
D
E

V
E
R
I
_
S
T
A
T
U
S
*

DECFL X X X

HEADER X X

LOCFL X X

MATCHFL X X X X X X X X X X X X

OKDEC X X X X X X X X X X X X

OKMATCH X X X X X X X X X X X X

RTE X X

TRAILER X X
Rev 2.2.1, Jul. 2006 HawkEye 1500 Series Reference & Programmers Manual 1-11
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ASSIGN

Description
This command assigns the learned decoder parameters from the indicated PID# 
to a trigger. When the specified trigger occurs (to initiate the read and decode of 
an image), the PID parameters are loaded into the decoder while the image is 
being acquired. This allows multiple learned symbols to be used when online.

Notes: We recommend you use the ASSIGNEX command in applications instead 
of ASSIGN, since we will be removing ASSIGN in future versions.

See also “LEARN” on page 1-68 and “STORE” on page 1-150.

Syntax
ASSIGN {pid} {trig}

Where: 

pid — The product ID number:

Range: 1 - 15, 99 (default)

trig — The trigger number:

Range: 0 - 27
1-12 HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006
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ASSIGNEX

Description
This command assigns the learned decoder parameters from the indicated PID# 
to a trigger. When the specified trigger occurs (to initiate the read and decode of 
an image), the PID parameters are loaded into the decoder while the image is 
being acquired. This allows multiple learned symbols to be used when online.

This command allows the setting of a single trigger. For example:

ASSIGNEX 4 {pid}

This command allows the inquiry of a single trigger. For example:

ASSIGNEX 4 ?

Note: See also “LEARN” on page 1-68 and “STORE” on page 1-150.

Syntax
ASSIGNEX {trig} {pid}

Where: 

pid — The product ID number:

Range: 1 - 15, 99 (default)

trig — The trigger number:

Range: 0 - 27
Rev 2.2.1, Jul. 2006 HawkEye 1500 Series Reference & Programmers Manual 1-13
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BARCODE

Description
This command controls all 1-D symbologies except BC412, Postnet, 
Pharmacode, and QR Code.

Syntax
BAR[CODE] {ON | OFF}
1-14 HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006
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BARCODE ENABLEMASK

Description
This command selects a combination of 1-D symbologies.

Syntax
BARCODE ENABLEMASK {mask}

Where:

mask — Is any of the following:

• bit 0 — Code 128

• bit 1 — Code 39

• bit 2 — Code 93

• bit 3 — I2of5

• bit 4 — Codabar

• bit 5 — UPC EN8

• bit 6 — UPC E

• bit 7 — UPC Supp

• bit 8 — PDF417

• bit 9 — BC412

• bit 10 — Postnet

• bit 11 — Pharmacode

• bit 12 — RSS-14

• bit 13 — RSS-LIMITED

• bit 14 — RSS-EXPANDED

• bit 15 — RSS-STACKED

• bit 16 — RSS-COMPOSITE
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• bit 17 — QR-CODE

You can turn on individually many barcode types using the following commands:

• BAR128 {?|ON|OFF}

• BAR25 {?|ON|OFF}

• BAR39 {?|ON|OFF}

• BAR412 {?|ON|OFF}

• BAR93 {?|ON|OFF}

• BARABAR {?|ON|OFF}

• BARUPC {?|ON|OFF}

• BARUPE {?|ON|OFF}

• BARUPS {?|ON|OFF}
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BARCONF

Description
This command sets the barcode confidence level. For barcodes that do not use 
checksum such as Code 39, I 2 of 5, Codabar, and BC412, the threshold value 
can help reduce potential mis-decodes. When the value is raised, a certain 
number of decodes must agree before the decode is declared successful. On the 
other hand, if the value is set too high, then a normally decodable but imperfect 
barcode may not be decoded.

Syntax
BARCONF {level}

Where:

level — Is the confidence level:

Range: 0 - 100
Default: 0 (Any possible decode is accepted)
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BARHGT

Description
This command sets the minimum and maximum height of a barcode.

Syntax
BARHGT {opt1} {opt2}

Where:

opt1 — Is either of the following:

– MIN (default: 4 pixels)

– MAX (default: 400 pixels)

opt2 — Is the height of the barcode:

Range: 4 - 400
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BARHPS

Description
This command sets the horizontal probe spacing in pixels.

Note: See also “BARVPS” on page 1-25.

Syntax
BARHPS {spacing}

Where:

spacing — Is the horizontal probe spacing:

Range: 8 - 256 pixels
Default: 16 pixels
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BARLEN

Description
This command sets the minimum and maximum length of a barcode. If barcodes 
of different type or size need to be decoded, each barcode should be learned 
separately and the barcode properties recorded by the user. To read them all, the 
barcode properties list should be manually set to contain all the barcode 
properties learned from each barcode.

Note: See also “BARWDT” on page 1-26.

Syntax
BARLEN {opt1} {opt2}

Where:

opt1 — Is either of the following:

– MIN (default: 20 pixels)

– MAX (default: 600 pixels)

opt2 — Is the length of the barcode:

Range: 20 - 600
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BARNUM

Description
This command sets the minimum and maximum number of barcodes to be 
decoded.

Syntax
BARNUM {opt1} {opt2}

Where:

opt1 — Is either of the following:

– MIN (default: 2)

– MAX (default: 100)

opt2 — Is the number of barcodes to be decoded:

Range: 2 - 100
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BARPRB

Description
This command sets the barcode search method.

Syntax
BARPRB {method}

Where:

method — Is one of the following:

– HORI

– HORI_VERT (default)

– VERT

– VERT_HORI
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BARQZ

Description
This command sets the barcode quiet zone length. If for any reason the quiet zone 
is less in the image due to camera setup restrictions, you can lower the length in 
order for the algorithm to accept shorter space as quiet zone. On the other hand, if 
the barcode is big in the FOV such that some space between two adjacent bars 
exceeds the value specified, then it is possible that this space will be detected as 
possible quiet zone. To avoid this situation, increase the value of length.

Note: Do not adjust this value unless you understand how the change will affect 
the system performance.

Syntax
BARQZ {length}

Where:

length — Is the quiet zone length:

Range: 5 - 100
Default: 12
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BARTHRES

Description
This command sets the barcode threshold out of 255 grayscale.

Syntax
BARTHRES {opt}

Where:

opt — Is the threshold:

Range: 5 - 100 grayscale levels
Default: 18
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BARVPS

Description
This command sets the vertical probe spacing in pixels.

Note: See also “BARHPS” on page 1-19.

Syntax
BARVPS {opt}

Where:

opt — Is the vertical probe spacing:

Range: 8 - 256 pixels
Default: 16 pixels
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BARWDT

Description
This command sets the minimum and maximum width of a barcode.

Note: See also “BARLEN” on page 1-20.

Syntax
BARWDT {opt1} {opt2}

Where:

opt1 — Is either of the following:

– MIN (default: 1 pixels)

– MAX (default: 100 pixels)

opt2 — Is the width of the barcode:

Range: 1 - 100
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BC_DECODE_NEAR_CENTER
See “FINETUNE” on page 1-54.
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BC_UPC_AS_EAN

Description
This command enables/disables the output of UPC as EAN. The default is OFF.

Syntax
BC_UPC_AS_EAN {ON|OFF}
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BCCHKSUM

Description
This command enables/disables BC412 check sum checking.

Syntax
BCCHKSUM {opt}

Where:

opt — Is either of the following:

– ON

– OFF (default)
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BCDECFWD

Description
This command allows BC412 to be decoded forward (left to right) or backward 
(right to left).

Syntax
BCDECFWD {opt}

Where:

opt — Is either of the following:

– ON (left to right); this is the default

– OFF (right to left)
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BCPOL

Description
This command sets the expected BC412 polarity.

Syntax
BCPOL {polarity}

Where:

polarity — Is one of the following:

– DL — Is Dark on Light

– LD — Is Light on Dark

– AUTO — Autoselect (default)
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BCSTART

Description
This command enables/disables BC412 start/stop checking.

Syntax

BCSTART {opt}

Where:

opt — Is either of the following:

– ON

– OFF (default)
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BEEP

Description
This command enables/disables decode results beeping.

Syntax
BEEP {opt}

Where:

opt — Is either of the following:

– Y

– N (default)
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CAPTURE

Description
This command sets the source of the images to the decoder.

Syntax
CAPTURE {source}

Where:

source — Is one of the following:

– CAMERA — Captures images through the camera. This is the default.

– DIAGNOSTIC — The FPGA generates a ramp image. Used for internal 
testing.

– FILES — Images are downloaded into the unit. Used for testing and 
debugging.
1-34 HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006



CELL SAMPLE

R
em

o
te

 C
o

m
m

an
d

s 
R

ef
er

en
ce

1

CELL SAMPLE

Description
This command sets cell sampling. ReadRunner program samples and averages 
portions of each cell to determine whether the cell is light or dark.

Syntax
CELL SAMPLE {pixels}

Where:

pixels — Is the number of pixels:

Range: 1 - 7 pixels
Default: 5 pixels
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CELL SIZE

Description
This command sets cell size.

Syntax
CELL SIZE {pixels}

Where:

pixels — Is the cell size:

Range: 2 - 20 pixels
Default: 6 pixels
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COLS

Description
This command specifies the number of columns to expect in the Data Matrix 
symbol. The algorithm uses the value specified without having to re-compute it 
from image to image.

Note: See also “ROWS” on page 1-139.

Syntax
COLS {columns}

Where:

columns — Is one of the following:

– cols — Range: 8 - 144

– AUTO — Autoselect (default)
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CONSOLE

Description
This command sets the vxWorks console to the serial port for debugging.

Note: If the HawkEye™ 1500 is in the vxWorks shell (CONSOLE 2) and needs to 
be returned to the standard command interface (CONSOLE 1), the following 
should be typed at the vxWorks prompt (“->”):

cmd “control”
cmd “console 1”

Syntax
CONSOLE {n}

Where:

n — Is the serial port number. The range is 0 - 2:

– 0 or 1 — The standard command console

– 2 — The vxWorks debugging console
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CONTRAST

Description
This is a read-only command that displays the results of the LEARN 
CALIBRATE command (maximum and minimum contrast range).

Syntax
CONTRAST ?

For example:

CONTRAST ?

yields:

CONTRAST 255 0
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CONTROL

Description
This command takes control of the camera to allow you to alter parameters.

Syntax
CONTROL
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DECFL

Description
This command customizes the unsuccessful decode output of the HawkEye™ 
1500.

Syntax
DECFL {cntrl} [""string""] [{Hdrcntrl} {Trlcntrl} {Beepcntrl}]

Where:

cntrl — Is the DECFL message active (Y or N)?

string — (1 - 39 characters); the string may include keyword substitution:

– ANGLE — This keyword reports the Data Matrix angle in degrees from 
0° to 359°.

– CHECKSUM — This keyword expands to the checksum of the 
characters in the appropriate Output Format String where the 
(CHECKSUM) keyword is inserted. The two character ASCII value 
representation of the Hexadecimal checksum (for example, 2E) is 
substituted in the Output string. The checksum is calculated as the 
Exclusive OR (XOR) of all the characters up to the (CHECKSUM) 
keyword, including the Header and the Trailer characters if 
(CHECKSUM) is placed at the end of the trailer string.

– TIMESTAMP — This keyword will be substituted with the current date 
and time.

Note: The following parameters are optional. However, it you enter one of them, 
you must enter all of them at the same time.

Hdrcntrl — Print the header before the DECFL string (Y or N)?

Trlcntrl — Print the trailer before the DECFL string (Y or N)?

Beepcntrl — Sound this many beeps (0 - 3) when this report is issued. The 
default is 0.
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DELETE

Description
This command deletes (invalidates) the stored PID.

Note: To save this deletion to flash, you must issue the SAVE command.

Syntax
DELETE {pid#}

Where:

pid# — Is the PID number:

Range: 1 - 15
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DHCP

Description
This command enables/disables DHCP.

Syntax
DHCP {opt}

Where:

opt — Is either of the following:

– Y (default)

– N
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DHCPEX

Description
This command enables/disables DHCP and sets up Automatic Private IP 
Addressing (APIPA), which assigns a camera IP address when no DHCP can be 
found.

Syntax
DHCP {Y | N} {APIPAIP} {APIPAMASK} {DHCPRETRYTIMER}

Where:

Y | N — Enable/disable DHCP.

APIPAIP — The template address that will be used by APIPA to form its new IP 
address in the absence of a DHCP server. When used with APIPAMASK, the 
unmasked portion of the address (.0.0) will be replaced with randomly generated 
address fields. This randomly created address was pre-qualified as not being seen 
to exist on the network in order to prevent duplicate assignment.

DHCPRETRYTIMER — (0 - 6000) The DHCP Retry Timer.

• When set to a number other than 0, the camera will continue to request a 
DHCP address forever, every “DHCP Reset Timer” number of seconds.

• When set to zero, if no DHCP server offers an address on the first request, 
the camera will fail over to APIPA address creation.
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DM_ALLOW_SEVERE_DAMAGE
See “FINETUNE” on page 1-54.
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DM_ALLOW_STEEP_ANGLE
See “FINETUNE” on page 1-54.
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DM_DECODE_NEAR_CENTER
See “FINETUNE” on page 1-54.
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DM_ENSURE_ROI
See “FINETUNE” on page 1-54.
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DOMAIN

Description
This command sets the default TCP/IP domain. For example:

acut.com

Syntax
DOMAIN {domain name}
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DWELLTIME

Description
This command sets the dwell time of the decoder.

Syntax
DWELLTIME {opt}

Where:

opt — Is the time in milliseconds:

Range: 0 - 60 ms
Default: 5 ms
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ECC

Description
This command sets Data Matrix expected Error Correction level. ECC 200 
employs Reed-Solomon error correction and is recommended for new 
applications. Other ECC levels (000, 050, 080, 100, 140) use the convolutional 
error encoding. ECC250 is customer-specific coding. The default value SPEC 
allows the algorithm to decode ECC000, 050, 080, 100, 140, and 200 that are 
included in the AIM/ISO Data Matrix Specification. If not specified, the older 
non-standard Data Matrix such as ECC120 can also be decoded.

Syntax
ECC {level}

Where:

level — Is one of the following:

– 0

– 50

– 80

– 100

– 140

– 200

– AUTO

– Spec (default)
Rev 2.2.1, Jul. 2006 HawkEye 1500 Series Reference & Programmers Manual 1-51



Chapter 1 Remote Commands Reference
EIPENABLE

Description
This command enables/disables Ethernet/IP communications.

Note: You must reboot the camera after enabling/disabling Ethernet/IP.

Syntax
EIPENABLE {opt}

Where: 

opt — Is either of the following:

– Y or ON — Enable Ethernet/IP.

– N or OFF — Disable Ethernet/IP (default)
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ENSURE CENTERED

Description
This command specifies whether or not the image needs to be centered.

Syntax
ENSURE CENT[ERED] {opt1} {opt2}

Where:

opt1 — Is either of the following:

– BARCODE — The camera decodes barcodes when the 
laser (central) line passes through all the bars and spaces.

– DM — The camera decodes Data Matrix when the center point 
of image is inside the Data Matrix

opt2 — Is either of the following:

– ON

– OFF (default)
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FINETUNE

Description
This command controls all decoder fine tuning options. It allows you to select the 
combination of decoder fine tuning options. By default, FINETUNE is ON.

Syntax
FINETUNE {ON | OFF}
FINETUNE ENABLEMASK {mask}

• bit 0 — POSITION_ENHANCE_ENABLED {ON/OFF} Default=Off

Enabling this option allows the algorithm to locate more precisely the four 
corners of the Data Matrix, and may improve the decode capability. This 
mode is left here for compatibility purposes.

• bit 1 — INTENSITY_ENHANCE_ENABLED {ON/OFF} Default=Off

Designed to overcome dramatic intensity variation over the matrix border 
area. For example, certain poorly marked Data Matrices may have some 
cells that are almost invisible compared to the rest of the cells. Without 
enabling the option, the system may issue a status/error code, indicating a 
certain edge cannot be found. Enabling the option will help read this type of 
Data Matrix more consistently.

• bit 2 — NO_QUIET_ZONE_CLUTTER {ON/OFF} Default=Off

Enabling this option speeds up the reading process when Data Matrix has 
sufficient quiet zone. With sufficient quiet zone, a Data Matrix with 
irregular, curved, or distorted border(s) can be read more efficiently with the 
option checked. Typically, the border problem is associated with low quality 
inkjet or dot peen marks or when the Data Matrix is imaged at an compound 
angle.

• bit 3 — NO_TOP_TIMING_BORDER {ON/OFF} Default=Off

The Top or Right timing borders refer to the timing borders on top or right of 
the Data Matrix when the Data Matrix has no rotation. Sometimes, a Data 
Matrix may be printed without the top timing border or the right timing 
border. To read this type of defective Data Matrix, first perform Learn Data 
Matrix. When it fails, follow the instructions in Status Bar:

a. Draw a box surrounding the Data Matrix without the timing border.
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b. Enter the correct Num Columns, Num Rows, and Polarity in the Data 
Matrix Parameter setup box.

c. Select Advanced to display the Advanced Parameter Tuning box.

d. Check No Top Timing Border in Finetune method.

e. Select OK twice to complete the Learn step. When Learn succeeds, the 
Data Matrix can be read in Run mode as if the top timing border were in 
place.

• bit 4 — NO_RIGHT_TIMING_BORDER {ON/OFF} Default=Off

Refer to the description for bit 3 when dealing with a defective Data Matrix 
without the right timing border.

• bit 5 — DM_ALLOW_STEEP_ANGLE {ON/OFF} Default=Off

In some Data Matrix reading applications, it is not possible to set up the 
camera such that the focal plane is in parallel with the surface of the Data 
Matrix label. When the focal plane and the label surface form a steep angle, 
the Data Matrix in the image will have severe geometrical distortion. Use the 
following steps to read severely distorted Data Matrix in any orientation:

a. Unlearn.

b. Set Number of Data Matrices to Decode to 1.

c. In Finetune Method, enable/check Allow Steep Angle. Now, the 
system is ready to read distorted Data Matrix in Run mode.

• bit 6 — DM_ALLOW_SEVERE_DAMAGE {ON/OFF} Default=Off

Enabling this option increases the robustness of the software in reading Data 
Matrix with severe border damages. To use it, first perform a successful 
Learn on a less damaged label. Then, enable (check) the option to read labels 
with more border damages in Run mode.

• bit 7 — DM_ENSURE_ROI {ON/OFF} Default=Off

Enabling this option ensures that no Data Matrix is located unless it is fully 
inside the ROI.
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• bit 8 — DM_DECODE_NEAR_CENTER {ON/OFF} Default=Off

Enabling this option allows a Data Matrix or barcode to be decoded only if 
the center of the ROI is inside the Data Matrix or barcode.

• bit 9 — BC_DECODE_NEAR_CENTER {ON/OFF} Default=Off

Enabling this option allows a Data Matrix or barcode to be decoded only if 
the center of the ROI is inside the Data Matrix or barcode.

Use the following command to set more than one flag at a time:

FINETUNE ENABLEMASK 0x26

where the bits for each selected option are set in the mask.

Alternatively, you can set each of the individual FINETUNE parameters singly. 
For example:

BC_DECODE_NEAR_CENTER {ON/OFF}

DM_ALLOW_SEVERE_DAMAGE {ON/OFF}

DM_ALLOW_STEEP_ANGLE {ON/OFF}

DM_DECODE_NEAR_CENTER {ON/OFF}

DM_ENSURE_ROI {ON|OFF}

INTENSITY_ENHANCE_ENABLED {ON/OFF}

NO_QUIET_ZONE_CLUTTER {ON/OFF}

NO_RIGHT_TIMING_BORDER {ON/OFF}

NO_TOP_TIMING_BORDER {ON/OFF}

POSITION_ENHANCE_ENABLED {ON/OFF}
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HEADER

Description
This command sets the Decode Output header to the indicated string. Use this 
command to specify the text that will precede the decoded output. For example, 
assume:

• HEADER string = “ACME Part Number: ”

• Decoded output = 123456

The output would look like:

ACME Part Number: 123456

Syntax
HEADER {““string””}

Where:

string — Is 1 to 80 characters. The default is NULL. String may include non-
printable control characters in the following format:

\0d = CR

\0A = LF

The string may include keyword substitution:

– CHECKSUM — This keyword expands to the checksum of the 
characters in the appropriate Output Format String where the 
(CHECKSUM) keyword is inserted. The two character ASCII value 
representation of the Hexadecimal checksum (for example, 2E) is 
substituted in the Output string. The checksum is calculated as the 
Exclusive OR (XOR) of all the characters up to the (CHECKSUM) 
keyword, including the Header and the Trailer characters if 
(CHECKSUM) is placed at the end of the trailer string.

– TIMESTAMP — This keyword will be substituted with the current date 
and time.
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HEIGHT

Description
This command sets the expected Data Matrix height.

Note: See also “RATIO” on page 1-128 and “WIDTH” on page 1-180.

Syntax
HEIGHT {opt}

Where:

opt — Is either of the following:

– height — Range: 20 - 1024

– AUTO — Autoselect (default)
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HELP

Description
This command displays remote commands and descriptions of how to use them.

• List all available commands:

HELP

• List help for a command:

HELP {cmd}

Where:

– cmd — Most remote commands

• List detailed help for a command:

HELP {cmd} V[ERBOSE]

Where:

– cmd — Select remote commands

– VERBOSE — Display detailed information about the command
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ILLUMINATION

Description
This command selects the lighting for the HawkEye™ 1500.

Syntax
ILLUM[INATION] {opt}

Where:

opt — Is one of the following:

– OFF — Use ambient lighting.

– ON — Use constant lighting (default).

– EXT — Use external lighting.

– STROBE — Use strobed lighting.

– POWER[_STROBE] — Use power stobed lighting.

– ON_AND_PSTROBED — Constant on with power strobing at trigger.
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INFORM

Description
This command specifies whether or not each issued command reports back the 
state of the command just changed.

Syntax
INFORM {opt}

Where:

opt — Is either of the following:

– ON

– OFF (default)
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INTENSITY_ENHANCE_ENABLED
See “FINETUNE” on page 1-54.
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IO_MODE

Description
This command selects the GPIO output mode.

Syntax
IO_MODE {mode} [duration]

Where:

mode — Is one of the following:

– NONE

– DV_2LINE_HS — HandShake mode with multiplexed (GOOD, FAIR, 
POOR, Locate Failure) and DataValid lines assigned. In this mode, the 
status is NOT cleared until the trigger goes away.

– DV_3LINE_HS — HandShake mode with GOOD, FAIR, POOR, and 
DataValid lines assigned. In this mode, the status is NOT cleared until 
the trigger goes away.

– DV_2LINE_PULSE — PULSE/PIPELINED with multiplexed 
(GOOD, FAIR, POOR, Locate Failure) and DataValid lines assigned 
with DataValid duration: 0 - 30,000ms.

– DV_3LINE_PULSE — PULSE/PIPELINED with GOOD, FAIR, 
POOR, and DataValid lines assigned with DataValid duration: 0 - 
30,000ms.

– DV_HS — HandShake mode with OPT1 = Pass, OPT2 = Fail, for 
duration.

– DV_PULSE — PULSE/PIPELINED with OPT1 = Pass | Fail, 
OPT3 = Data Valid, for duration.

– HE_HS — HandShake Mode with OPT1 = Pass, OPT2 = Fail.

– HE_PULSE — PULSE/PIPELINED Mode with OPT1 = Pass, 
OPT2 = Fail, for duration.

duration — Is the pulse duration. In pulse mode, the status is NOT cleared until 
the trigger goes away. The range is 0 - 30,000ms.
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IOASSIGN

Description
This command allows variables defined with the SET_CRITERIA command to 
be assigned to digital output lines.

Note: Use the SET_CRITERIA command to configure variable_name definitions 
before assigning them to an output bit

Syntax
IOASSIGN {BIT} {variable_name}

Where:

• BIT — A valid output point. Valid points include OPTO_OUT1 to 
OPTO_OUT3 and GPIO_OUT1 to GPIO_OUT4.

• variable_name — Is one of the following:

– ANGLE_FAILURE — Signals when the measured angle is outside of 
the user’s process limits

– LOCATE_FAILURE — may be used as an overall indicator or masked 
to signal particular types of locate failures.

– DECODE_FAILURE — If used when Match Mode is enabled, it allows 
the user to distinguish between NO MATCH with a successful Decode 
and NO MATCH with an unsuccessful Decode

– RTE — Run time error, including Trigger Overruns, Decode Overruns, 
and Network errors

– PASS — may also represent a MATCHED state if a Match Mode is 
enabled

– FAIL — may also represent a NO MATCH state if a Match Mode is 
enabled

– DV — Data Valid

– GOOD — (used by the Verification option)
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– FAIR — (used by the Verification option)

– POOR — (used by the Verification option)

Use the CLEAR keyword to disable an I/O assignment; for example:

IOASSIGN GPIO_OUT2 CLEAR

You can display the state of a single assignment; for example:

IOASSIGN GPIO_OUT2 ?

You can display the state of all assignments; for example:

IOASSIGN ?
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IP

Description
This command sets up the static IP address when DHCP is disabled. The camera 
name is used for DHCP or static addressing.

Syntax
IP {cameraname} {ipaddress} {subnetmask} {gateway}

Where:

cameraname — Is the name of the camera.

ipaddress — Is the static IP address.

subnetmask — Is the subnet mask.

gateway — Is the gateway address.
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IPCONFIG

Description
This command returns the current name, IP address, and subnet mask of the 
camera.

Syntax
IPCONFIG {hostname} {ipaddress} {subnetmask}

Where:

hostname — Is the name of the camera

ipaddress — Is the IP address of the camera

subnetmask — Is the subnet mask of the camera
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LEARN

Description
This command initiates a learn sequence. The LEARN command narrows down 
the parameters associated with a symbol. This results in a more reliable decode of 
the same type of symbol. In most cases, it speeds up the decoding time. You can 
use the LEARN command in combination with the ASSIGN, PID, STORE, and 
TRIG commands.

Once the LEARN command is issued, all symbols that are being read must be of 
the same type and size in order to be decoded. In order to open up the decoder to 
all possible types of symbols again, issue the UNLEARN command.

You can also issue a LEARN command using QuicSet®:

1. Enter QuicSet® by pressing the QuicSet® recessed button (using a paper 
clip) once.

2. Learn the next acquired image by pressing the recessed button two more 
times quickly.

3. Exit QuicSet® by pressing the recessed button again.

Note: See also “LEARNASSIST” on page 1-69 and “UNLEARN” on page 1-168.

Syntax
LEARN {opt}

Where:

opt — Is one of the following:

– Both (default)

– 1D

– 2D

– None

– Calibrate
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LEARNASSIST

Description
This command narrows down the parameters associated with a symbol. This 
results in a more reliable decode of the same type of symbol. In most cases, it 
speeds up the decoding time.

Note: See also “LEARN” on page 1-68 and “UNLEARN” on page 1-168.

Syntax
LEARNASSIST {p1x,p1y,p2x,p2y,p3x,p3y,p4x,p4y} {rows}{cols}{polarity}

Where:

p1x,p1y,p2x,p2y,p3x,p3y,p4x,p4y — Clockwise, the x and y of the four corners.

rows — The number of rows to expect in the Data Matrix symbol:

Range: 8 - 144, or AUTO — Autoselect (default)

cols — The number of columns to expect in the Data Matrix symbol:

Range: 8 - 144, or AUTO — Autoselect (default)

polarity — Is one of the following:

– Dark on light

– Light on dark

– AUTO (default)
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LEARNCANCEL

Description
This command cancels a learn request that is waiting to be executed when the 
next trigger occurs. This occurs when you issue a learn and the unit is in TRIG T 
mode, waiting for a trigger.

Syntax
LEARNCANCEL
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LOAD

Description
This command loads info from a job or PID.

Syntax
LOAD {pid# | saved | default}

Where:

pid# — Load/use decoder settings from a PID. This overwrites all the decoder 
configurable parameters.

Range: 0 - 15, and 99

saved — Load the saved job, and all other system, reporting, communication and 
application parameters.

default — Load factory default settings for a job.
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LOCFL

Description
This command customizes the Locator Failure output of the HawkEye™ 1500.

Syntax
LOCFL {cntrl} [""string""] [{Hdrcntrl} {Trlcntrl} {Beepcntrl}]

Where:

cntrl — Is the LOCFL message active (Y or N)?

string — (1 - 39 characters); the string may include keyword substitution:

Note: If the location of the Data Matrix fails, this will be reported as -1°.

– CHECKSUM — This keyword expands to the checksum of the 
characters in the appropriate Output Format String where the 
(CHECKSUM) keyword is inserted. The two character ASCII value 
representation of the Hexadecimal checksum (for example, 2E) is 
substituted in the Output string. The checksum is calculated as the 
Exclusive OR (XOR) of all the characters up to the (CHECKSUM) 
keyword, including the Header and the Trailer characters if 
(CHECKSUM) is placed at the end of the trailer string.

– TIMESTAMP — This keyword will be substituted with the current date 
and time.

Note: The following parameters are optional. However, it you enter one of them, 
you must enter all of them at the same time.

Hdrcntrl — Print the header before the LOCFL string (Y or N)?

Trlcntrl — Print the trailer before the LOCFL string (Y or N)?

Beepcntrl — Sound this many beeps (0 - 3) when this report is issued. The 
default is 0.
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MACADDR

Description
This command returns the MAC address for the unit. The address is set at the 
factory and cannot be reprogrammed in the field.

Syntax
MACADDR ?

For example:

MACADDR xx:xx:xx:xx:xx:xx
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MATCH

Description
This command sets match control.

See the following related commands:

• “MATCHCOUNT” on page 1-79

• “MATCHEX” on page 1-80

• “MATCHSERIAL” on page 1-84

• “MATCHSTRING” on page 1-85

Syntax
MATCH {opt} 

Where:

opt — Is one of the following:

– N — No match control (default).

– T — Text string matching.

– S — Serial string matching.

– B — Both text string and serial string matching.

Behavior of the Wildcard Match
The behavior of the wildcard match is:

• A case sensitive match is performed.

• * and ? are wildcard characters in the pattern as well as potentially valid 
characters in the string.

• * as a wildcard character represents 0 or more characters in a string.

• ? as a wildcard character represents 1 and only 1 character in a string.

• If * and ? are found in the string, the pattern can have either a * or ? 
describing that position, however, the pattern will also match any string with 
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something at that position other than * or ? (i.e., the * and ? in the pattern are 
seen as wildcards first and characters second).

Examples of this behavior are:

“*string” matches “?string”

“*string” matches “*string”

“*string” matches “any string”

“*string” matches “string”

“?string” matches “?string”

“?string” matches “*string”

“?string” matches “Xstring”
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MATCH_LIST

Description
This command allows you to enter match strings into the MATCH_LIST table, 
which allows match string to be associated with output values. The list is 
processed from top to bottom to find the first matching string. The string_value 
associated with the match string is output through the digital I/O lines with the 
assigned MATCH_BIT_1 through MATCH_BIT_4 tags.

For example, using the following commands to define a MATCH_LIST table:

MATCH_LIST 2 “*AB??”
MATCH_LIST 11 “*ZZ*”

the strings “ABCD” and “HELLOAB12” would match list entry 2 and 
MATCH_BIT_2 would be enabled. If the string were “ZZ” or “xyZZ1234”, it 
would match list entry 11 and MATCH_BIT_1, MATCH_BIT_2, and 
MATCH_BIT_4 would be enabled.

The MATCH_BITS correspond to the hexadecimal encoding of the string_value.

Note: The multi-character wildcard is * and represents 0 to N character 
positions in the string. The single character wildcard is ? and represents one 
character position in the string.

Clear an entry by entering an empty string such as MATCH_LIST 11 ““.

Syntax
MATCH_LIST {1-15} “match string”

Behavior of the Wildcard Match
The behavior of the wildcard match is:

• A case sensitive match is performed.

• * and ? are wildcard characters in the pattern as well as potentially valid 
characters in the string.

• * as a wildcard character represents 0 or more characters in a string.

• ? as a wildcard character represents 1 and only 1 character in a string.
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• If * and ? are found in the string, the pattern can have either a * or ? 
describing that position, however, the pattern will also match any string with 
something at that position other than * or ? (i.e., the * and ? in the pattern are 
seen as wildcards first and characters second).

Examples of this behavior are:

“*string” matches “?string”

“*string” matches “*string”

“*string” matches “any string”

“*string” matches “string”

“?string” matches “?string”

“?string” matches “*string”

“?string” matches “Xstring”
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MATCH_LIST_ENABLE

Description
This command specifies whether or not the match list will be used in MATCH 
mode. When MATCH or MATCHEX is configured for text (T) or both (B), 
MATCH_LIST_ENABLE directs the camera to use the set of strings defined 
with the MATCH_LIST command rather than the MATCH or MATCHEX 
command.

Syntax
MATCH_LIST_ENABLE {opt}

Where:

opt — Is one of the following:

– ON

– OFF (default)
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MATCHCOUNT

Description
This command sets the initial match count.

See the following related commands:

• “MATCH” on page 1-74

• “MATCHEX” on page 1-80

• “MATCHSERIAL” on page 1-84

• “MATCHSTRING” on page 1-85

Syntax

MATCHCOUNT count

Where:

count — Is the initial count:

Range: 0 - 0x7FFFFFFF
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MATCHEX

Description
This command sets various match parameters in one command.

See the following related commands:

• “MATCH” on page 1-74

• “MATCHCOUNT” on page 1-79

• “MATCHSERIAL” on page 1-84

• “MATCHSTRING” on page 1-85

Syntax
MATCHEX {control} {string} {count} {incr} {1stchar} {lastchar}

Where:

control — Is one of the following:

N — No match control (default).

T — Text string matching.

S — Serial string matching.

B — Both text string and serial string matching.

string — Is a string, which may include wildcards:

? — Single don’t care
* — Multiple don’t cares

Range: 1 - 30 upper and/or lowercase letters

count — Is the initial count.

Range: 0 0x7FFFFFFF

incr — The increment value to be added after each inspection.

Range: -1000 thru +1000
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1st char — The first character in the decode string to be included in the serial 
number.

Range: 1 - 1000

last char — The last character in the serial number.

Range: 1st char - 1000
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MATCHFL

Description
This command customizes the unsuccessful match (nomatch) output of the 
HawkEye™ 1500.

Syntax
MATCHFL {cntrl} [""string""] [{Hdrcntrl} {Trlcntrl} {Beepcntrl}]

Where:

cntrl — Is the MATCHFL message active (Y or N)?

string — (1 - 39 characters); the string may include keyword substitution:

– ANGLE — This keyword reports the Data Matrix angle in degrees from 
0° to 359°.

– CHECKSUM — This keyword expands to the checksum of the 
characters in the appropriate Output Format String where the 
(CHECKSUM) keyword is inserted. The two character ASCII value 
representation of the Hexadecimal checksum (for example, 2E) is 
substituted in the Output string. The checksum is calculated as the 
Exclusive OR (XOR) of all the characters up to the (CHECKSUM) 
keyword, including the Header and the Trailer characters if 
(CHECKSUM) is placed at the end of the trailer string.

– DATA — This keyword will be substituted with the actual decoded 
string. For example, if “4567321” were decoded, and the event were set 
as “OKDEC: This is the decoded data: (DATA)\0d\0a” then the one line 
of output would look like the following:

This is the decoded data: 4567321

– DATAHEX — This keyword converts the decode data to a hex 
character string, similar to the previous “OUTPUT FORMAT HEX” 
functionality.

– DETAILED — This keyword returns a detailed failure string.

– PID# — This keyword returns the PID number of the PID that 
successfully decoded the symbol.
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– TIMESTAMP — This keyword will be substituted with the current date 
and time.

– VERI_1_IAQG — This keyword provides a DMx AutoID compatibility 
mode for the IAQG Verification I report.

– VERI_DETAIL — This keyword will be substituted with very detailed 
AIM information: Overall Grade, Grade Contrast, Contrast, Grade axial 
nonuniformity, Axial nonuniformity, Grade of print growth, Print 
growth x, Print growth y, Grade of error correction, Num error bits UEC 
value.

– VERI_FORMATTED — This keyword (typically placed in the OKDEC 
formatted string) puts out the verification data with the following 
format:
OG:3 CG:3 C:65 nG:4 n:0.00 GPG:3 PGx:0.20 PGY:0.02 GUEC:4 #B:0 UEC:1.00

– VERI_GRADE — This keyword will be substituted with the AIM 
grade. The string may also include non printable control characters by 
typing the backslash character followed by the two character hex 
number that represents the character. For example, \0d is a CR and \0A 
is a LF.

Note: The following parameters are optional. However, it you enter one of them, 
you must enter all of them at the same time.

Hdrcntrl — Print the header before the MATCHFL string (Y or N)?

Trlcntrl — Print the trailer before the MATCHFL string (Y or N)?

Beepcntrl — Sound this many beeps (0 - 3) when this report is issued. The 
default is 2.
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MATCHSERIAL

Description
This command specifies serial checking parameters.

See the following related commands:

• “MATCHCOUNT” on page 1-79.

• “MATCHEX” on page 1-80

• “MATCHSTRING” on page 1-85.

Syntax
MATCHSERIAL {incr} {1st char} {last char}

Where:

incr — The increment value to be added after each inspection.

Range: -1000 thru +1000

1st char — The first character of the serial number to compare.

Range: 1 - 1000

last char — The last character in the serial number to compare.

Range: 1st char - 1000
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MATCHSTRING

Description
This command sets match control to character matching. In simple applications, 
where the line is set up to compare the code read to a fixed string, you would use 
MATCH T (“string”). In other words, every part read must be the same. You 
would have different triggers assigned to different PIDs such that there is a 
different string to compare, depending on the trigger.

See the following related commands:

• “MATCHCOUNT” on page 1-79.

• “MATCHEX” on page 1-80

• “MATCHSTRING” on page 1-85.

Syntax
MATCHSTRING {string}

Where:

string — Is a string, which may include wildcards:

? — Single don’t care
* — Multiple don’t cares

Range: 1 - 80 upper and/or lowercase letters
Default: Null

String may include non-printable control characters in the 
following format:

\0d = CR

\0A = LF
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MORPHOLOGY

Description
This command sets the morphological pre-processing of the image.

Syntax
MORPHOLOGY {opt} [num]

Where:

opt — Is one of the following:

– ADAPTIVE — Hand-Held Demo mode where it tries no image 
processing first; if it fails, it tries Erode, if it fails, it tries Dilate.

– CLOSE — DILATE and then ERODE (remove minor dark defects of 
light cells)

– DILATE — Dilate light pixels and erode dark pixels

– ERODE — Erode light pixels and dilate dark pixels (increase dark cell 
size and reduce light cell size)

– NONE (default)

– OPEN — ERODE and then DILATE (remove minor light defects of 
dark cells)

num — Is the number of passes:

Range: 1 - 5
Default: 1
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NO_QUIET_ZONE_CLUTTER
See “FINETUNE” on page 1-54.
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NO_RIGHT_TIMING_BORDER
See “FINETUNE” on page 1-54.
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NO_TOP_TIMING_BORDER
See “FINETUNE” on page 1-54.
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NUMBC

Description
This command sets the number of barcodes in a field of view to decode. To look 
for Data Matrix only, use NUMBC 0.

Syntax
NUMBC {n}

Where:

n — Is the number of barcodes to decode:

Range: 0 - 1
Default: 1
1-90 HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006



NUMDM

R
em

o
te

 C
o

m
m

an
d

s 
R

ef
er

en
ce

1

NUMDM

Description
This command specifies the maximum number of Data Matrix symbols to find. 
To look for 1-D only, use NUMDM 0.

Syntax
NUMDM {n}

Where:

n — Is the maximum number of Data Matrix symbols to find:

– 0 — Disable/No look

– 1 (default)
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OFFLINE

Description
This command returns the unit to offline so that you can program it.

Syntax
OFFLINE
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OKDEC

Description
This command customizes the successful decode output of the HawkEye™ 1500.

Syntax
OKDEC {cntrl} [""string""] [{Hdrcntrl} {Trlcntrl} {Beepcntrl}]

Where:

cntrl — Is the OKDEC message active (Y or N)?

string — (1 - 39 characters); the string may include keyword substitution (in 
parentheses):

– ANGLE — This keyword reports the Data Matrix angle in degrees from 
0° to 359°.

– CHECKSUM — This keyword expands to the checksum of the 
characters in the appropriate Output Format String where the 
(CHECKSUM) keyword is inserted. The two character ASCII value 
representation of the Hexadecimal checksum (for example, 2E) is 
substituted in the Output string. The checksum is calculated as the 
Exclusive OR (XOR) of all the characters up to the (CHECKSUM) 
keyword, including the Header and the Trailer characters if 
(CHECKSUM) is placed at the end of the trailer string.

– DATA — This keyword will be substituted with the actual decoded 
string. For example, if “4567321” were decoded, and the event were set 
as “OKDEC: This is the decoded data: (DATA)\0d\0a” then the one line 
of output would look like the following:

This is the decoded data: 4567321

– DATAHEX — This keyword converts the decode data to a hex 
character string, similar to the previous “OUTPUT FORMAT HEX” 
functionality.

– DETAILED — This keyword returns a detailed failure string.

– PID# — This keyword returns the PID number of the PID that 
successfully decoded the symbol.
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– TIMESTAMP — This keyword will be substituted with the current date 
and time.

– VERI_1_IAQG — This keyword provides a DMx AutoID compatibility 
mode for the IAQG Verification I report.

– VERI_DETAIL — This keyword will be substituted with very detailed 
AIM information: Overall Grade, Grade Contrast, Contrast, Grade axial 
nonuniformity, Axial nonuniformity, Grade of print growth, Print 
growth x, Print growth y, Grade of error correction, Num error bits UEC 
value.

– VERI_FORMATTED — This keyword (typically placed in the OKDEC 
formatted string) puts out the verification data with the following 
format. 
OG:3 CG:3 C:65 nG:4 n:0.00 GPG:3 PGx:0.20 PGY:0.02 GUEC:4 #B:0 UEC:1.00

– VERI_GRADE — This keyword will be substituted with the AIM 
grade. The string may also include non printable control characters by 
typing the backslash character followed by the two character hex 
number that represents the character. For example, \0d is a CR and \0A 
is a LF.

Note: The following parameters are optional. However, it you enter one of them, 
you must enter all of them at the same time.

Hdrcntrl — Print the header before the OKDEC string (Y or N)?

Trlcntrl — Print the trailer before the OKDEC string (Y or N)?

Beepcntrl — Sound this many beeps (0 - 3) when this report is issued. The 
default is 0.
1-94 HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006



OKMATCH

R
em

o
te

 C
o

m
m

an
d

s 
R

ef
er

en
ce

1

OKMATCH

Description
This command customizes the successful match output of the HawkEye™ 1500.

Syntax
OKMATCH {cntrl} [""string""] [{Hdrcntrl} {Trlcntrl} {Beepcntrl}]

Where:

cntrl — Is the OKMATCH message active (Y or N)?

string — (1 - 39 characters); the string may include keyword substitution:

– ANGLE — This keyword reports the Data Matrix angle in degrees from 
0° to 359°.

– CHECKSUM — This keyword expands to the checksum of the 
characters in the appropriate Output Format String where the 
(CHECKSUM) keyword is inserted. The two character ASCII value 
representation of the Hexadecimal checksum (for example, 2E) is 
substituted in the Output string. The checksum is calculated as the 
Exclusive OR (XOR) of all the characters up to the (CHECKSUM) 
keyword, including the Header and the Trailer characters if 
(CHECKSUM) is placed at the end of the trailer string.

– DATA — This keyword will be substituted with the actual decoded 
string. For example, if “4567321” were decoded, and the event were set 
as “OKDEC: This is the decoded data: (DATA)\0d\0a” then the one line 
of output would look like the following:

This is the decoded data: 4567321

– DATAHEX — This keyword converts the decode data to a hex 
character string, similar to the previous “OUTPUT FORMAT HEX” 
functionality.

– DETAILED — This keyword returns a detailed failure string.

– PID# — This keyword returns the PID number of the PID that 
successfully decoded the symbol.
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– TIMESTAMP — This keyword will be substituted with the current date 
and time.

– VERI_1_IAQG — This keyword provides a DMx AutoID compatibility 
mode for the IAQG Verification I report.

– VERI_DETAIL — This keyword will be substituted with very detailed 
AIM information: Overall Grade, Grade Contrast, Contrast, Grade axial 
nonuniformity, Axial nonuniformity, Grade of print growth, Print 
growth x, Print growth y, Grade of error correction, Num error bits UEC 
value.

– VERI_FORMATTED — This keyword (typically placed in the OKDEC 
formatted string) puts out the verification data with the following 
format. 
OG:3 CG:3 C:65 nG:4 n:0.00 GPG:3 PGx:0.20 PGY:0.02 GUEC:4 #B:0 UEC:1.00

– VERI_GRADE — This keyword will be substituted with the AIM 
grade. The string may also include non printable control characters by 
typing the backslash character followed by the two character hex 
number that represents the character. For example, \0d is a CR and \0A 
is a LF.

Note: The following parameters are optional. However, it you enter one of them, 
you must enter all of them at the same time.

Hdrcntrl — Print the header before the OKMATCH string (Y or N)?

Trlcntrl — Print the trailer before the OKMATCH string (Y or N)?

Beepcntrl — Sound this many beeps (0 - 3) when this report is issued. The 
default is 0.
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ONLINE

Description
This command puts the unit online performing the desired application. When 
returning to online mode, the unit will beep three times rapidly and the Mode 
light will return to solid yellow.

Syntax
ONLINE
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ORIENT

Description
This command sets the matrix orientation in read mode. Orientation is set 
automatically by Learn which works for Read if matrix orientation does not 
change more than ± 45°. Otherwise, use ORIENT AUTO.

Note: All measurements are assumed to be rotated in a counter clockwise 
direction.

Syntax
ORIENT {orientation | AUTO}

Where:

orientation — Is one of the following:

– 1 = 0°

– 2 = 90°

– 3 = 180°

– 4 = 270°

– 5 = 45°

– 6 = 135°

– 7 = 225°

– 8 = 315°

– AUTO — Autoselect (default)
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OUTPUT

Description

• To set up the different output states on the different ports:

OUTPUT {PORT} {STATE} {FORMAT STRING} {ACTIVE} {H/T CONTROL}

• To set up the header/trailer strings for the different ports:

OUTPUT {PORT} H_T {FORMAT STRING} (FORMAT STRING}

Where:

– PORT — Is one of the following:

• STANDARD (Camera’s serial port)

• TCP1

• TCP2

• TCP3

• TCP4

– STATE — Is one of the following:

• OKDEC (see page 1–93)

• DECFL (see page 1–41)

• LOCFL (see page 1–72)

• OKMATCH (see page 1–95)

• MATCHFL (see page 1–82)

• RTE (see page 1–140)

– FORMAT STRING — Is the format string in quotes, or without quotes, 
if no spaces are needed

– ACTIVE — For whatever you want to use, sets STATE on or off for the 
particular PORT, and is one of the following:

• Y or ON or ENABLE
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• N or OFF or DISABLE

– H/T CONTROL — Activates the header and/or trailer, and is one of the 
following:

• NONE

• H — Header

• T — Trailer

• H_T — Both header and trailer

• To configure the different BEEP settings:

OUTPUT BEEP {OKDEC} {DECFL} {LOCFL} {OKMATCH} {NOMATCH} {RTE}

 Each setting indicates the number of beeps to use on each possible output 
(0 | 1 | 2).

The original OKDEC, DECFL, RTE et al., commands set up the STANDARD 
and TCP1 settings only, and the beeps.
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PARTQ

Description
This command enables/disables the part queue mechanism. The part queue stores 
a number of cycle reports in-line with the running inspection. The records are 
stored as a re-usable queue, that is, when the queue is full, the newest record 
replaces the oldest record. The part queue is loss-less.

Syntax
PARTQ {opt} [qualifier] [size]

Where:

opt — Is one of the following:

– Y — Enable the part queue

– N — Disable the part queue

– R — Save reports without saving images

qualifier — Specifies what you want to store.

– All — Store all records

– Passed — Store records of passed inspections

– Failed — Store records of failed inspections

size — The number of records to store:

Range: 1 - 100000
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PARTQCAPACITY

Description
This command obtains the maximum record count based on free memory in the 
camera for records with images and records without images in the PartQ 
configuration.

Syntax
PARTQCAPACITY {First value} {Second value}

Where:

• First value — Maximum number of records with images

• Second value — Maximum number of records without images

For example:

PARTQCAPACITY 31 5700
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PARTQCLEAR

Description
This command clears the current records in the part queue.

Syntax
PARTQCLEAR
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PARTQCOUNT

Description
This command displays the current number of records in the part queue.

Syntax
PARTQCOUNT
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PARTQFAIL

Description
This command specifies the exact failure to store in the part queue when it is set 
to Failed qualification.

Syntax
PARTQFAIL {qualifier}

Where:

qualifier — Specifies the exact failure you want to store:

– ALL

– DECFL

– LOCFL

– MATCHFL

– RTE
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PARTQFTP

Description
This command sets up the Part Queue to save each image remotely as it occurs. 
The files constructed are:

PATH/CameraName_{CycleCount|PartQ Index}_DecodeResult.{txt|bmp}

Where:

• CameraName — Is the name of the camera (e.g., hawkeye)

• CycleCount — Is a 9-digit decimal cycle count (e.g., 000012345)

• PartQ Index — Is a 4-digit part queue index (e.g., 0245)

• DecodeResult — Is the overall result:

– OKDEC

– DECFL

– LOCFL

– OKMATCH

– MATCHFL

– RTE

File Examples:

path/hawkeye_000001304_OKDEC.txt

path/hawkeye_000001304_OKDEC.bmp

If the Part Queue is configured with a maximum limit, then the PartQ Index is 
used instead of the cycle count. Files that already exist (after wrap-around) are 
overwritten. If the Part Queue is configured with no limit (0), then the 
CycleCount will be used in the file name instead.

The .TXT file contains tab-delimited version of the results:

Cycle Count:<tab>000000000

Passed:<tab>000000000
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...

Decode Data:<tab>{decoded data}

The Decode Data is not converted to any specific format; it is simply saved as is.

Syntax
PARTQFTP {HOST} {PATH} {SAVERESULTS} {SAVEIMAGE}

Where:

HOST — IP address of the FTP server; if "", files saved locally

PATH — Path on FTP server where files are saved

SAVERESULTS — Y or N to save a .TXT results file

SAVEIMAGE — Y or N to save the image as a bitmap (no graphics)
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PARTQFTPEX

Description
This command controls the number of records to collect when directing the 
PARTQ to send records to the host system directly using FTP. The numbering in 
the file names of transferred records is also affected by this parameter.

Syntax
PARTQFTPEX {host} {path} {save results} {save image} {count}

Where:

host — IP address of the FTP server; if ““, files are saved locally.

path — Path on FTP server where files are saved.

save results — Y or N to save a .TXT results file.

save image — Y or N to save the image as a formatted bitmap (no graphics).

count — Is either of the following:

• 0 — Records with the file names containing a 9-digit decimal representation 
of the cycle count "_000000000_".

• 1-9999 — Sequentially labeled records with the file names containing a 
4-digit representation "_0000_", wrapping at N records and overwriting old 
records.
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PARTQREQ

Description
This command uploads the part queue. You can upload the entire queue or a 
single entry.

Syntax
PARTQREQ {compression} {opt2} {preserve}

Where:

compression — Specify compression of images when uploading via the serial 
port. Compression is not used when uploading via TCP/IP. Compression is one of 
the following:

– 0 - No compression applies; image uploaded in full

– 26 - Decimated image

– 27 - Decimated image with JPEG quality

– 255 - No compression applies; image uploaded in full

opt2 — Is either of the following:

– # — Upload a specific entry in the queue

– All — Upload all entries; this is the default

preserve — Is either of the following:

– When preserve is specified, do not clear the queue.

– When preserve is not specified, clear the queue.
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PARTQREQFORMAT

Description
This command allows user defined parts of the cycle records stored on the 
camera to be retrieved on demand.

Syntax
PARTQREQFORMAT {FORMAT STRING} {ALL | #}

Where:

• FORMAT STRING — Specifies the desired format of the data to retrieve 
using the new CDxx (see Table 1–11) and IDxx (see Table 1–12) tags, the 
same as the OUTPUT command.

• ALL | # — Is the specific record, either ALL or by index in the queue; 0 is 
the oldest up to N (the newest), stored on the camera. The number of records 
can be obtained by using the PARTQCOUNT command.

TABLE 1–11. CD Fields

Field Description

00 All Data

01 Overall Pass/Fail

02 Count of triggers

03 Count of passes

04 Count of failures

05 Count of successful locates

06 Count of failed locates

07 Count of successful decodes

08 Count of failed decodes

09 Count of successful matches

10 Count of failed matches

11 Count of alarms

12 Count of trigger overruns

13 Count of decode overruns

14 Count of acquisition timeouts
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15 PID

16 Symbol Pass/Fail

17 Located / Not Located

18 Decoded / Not Decoded

19 Matched / Not Matched (0) (0 if matching is not active)

20 Detailed Decode Failure

21 Overall AIM Verification Grade

22 Unformatted decode data

Length/raw data

23 Photometry Settings

Auto|Manual/Gain/Exposure

24 Image Timestamp

25 Image Data Raw

Width/Height/Gray-scale values

TABLE 1–12. ID Fields

Field Description

01 Image Data Bmp
32-bit Length/Binary values

02 Image Data Tiff
32-bit Length/Binary values

TABLE 1–11. CD Fields (Continued)

Field Description
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PARTQSAVE

Description
This command saves the current queue to a remote path on demand (the cycle 
records are stored on the camera in Memory).

Note: The cycle records on the Camera are cleared by this operation afterwards.

Syntax
PARTQSAVE {HOST} {PATH} {SAVERESULTS} {SAVEIMAGE}

Where:

HOST — IP address of the FTP server; if "", files are saved locally

PATH — Path on FTP server where files are saved

SAVERESULTS — Y or N to save a .TXT results file

SAVEIMAGE — Y or N to save the image as a bitmap (no graphics)
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PARTQSUM

Description
This command displays a summary of the part queue.

Syntax
PARTQSUM {opt1}

Where:

opt1 — Is the kind of summary to display:

– All — Display a complete summary. This is the default.

– # — Display a summary of the # record. This is a zero-based index.
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PHOTOEX

Description
This command sets both Auto and Manual settings in one command.

Syntax
PHOTOEX {opt1} {opt2} {opt3} {opt4} {opt5} {opt6} {opt7}

Where:

opt1 — Sets the Photometry control:

– AUTO

– MANUAL — Sets the operating Gain and Exposure

opt2 — The desired exposure if Manual control is selected

opt3 — The desired gain if Manual control is selected. Sets up the range for 
the auto photometry algorithm if Auto control.

opt4 — Min exposure — The minimum shutter/exposure duration value used 
for Auto control. (30 - 100,000 usec)

opt5 — Max exposure — The maximum shutter/exposure 
duration value used for Auto control. (Min exp - 100,000 usec)

opt6 — Min gain — The minimum gain value used for Auto control. (0 - 1023)

opt7 — Max gain — The maximum gain value used for Auto control. 
(Min Gain - 1023)
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PHOTOMETRY

Description
This command selects Photometry settings and controls. An application can use 
user selected gain and exposure or it can use the auto-photometry algorithm to 
determine the correct settings at each trigger.

Syntax

• Define automatic photometry control. Perform photometry control at each 
trigger and prior to each image scan:

PHOTOMETRY AUTOMATIC [opt2] [opt3] [opt4] [opt5]

Where:

opt2 — Min exposure — The minimum shutter/exposure duration value 
used for Auto control. (30 - 100,000 usec)

opt3 — Max exposure — The maximum shutter/exposure duration 
value used for Auto control. (Min exp - 100,000 usec)

opt4 — Min Gain — The minimum gain value used for Auto control. 
(0 - 1023)

opt5 — Max Gain — The maximum gain value used for Auto control. 
(Min Gain - 1023)

• Define manual photometry control. Do not perform automatic photometry at 
each trigger. If opt2 and opt3 are supplied, use these values at each scan. 
Each PID can have its own gain and exposure settings:

PHOTOMETRY MANUAL [opt2] [opt3]

Where:

opt2 — Exposure range (30 - 100,000 usec)

opt3 — Gain (0 - 1023)
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PID

Description
This command allows you to train the decoder to rapidly and accurately decode 
the symbol in the current field of view. After the parameters are established, you 
can save the predictable parameters with the STORE command. The camera can 
store up to 15 predictable parameter sets, which are identified by ID 1 - 15 
(PIDs).

Each PID contains the following information:

By default, Siemens supplies factory default PID99, which is programmed to 
read most codes with the HawkEye™ 1500. The default parameters are loaded 
into the current working area at boot time. After you start changing parameters 
from the ones in the current working area, the PID number changes to PID0, 
indicating that it has no home. You should store the info to a PID so that when 
you issue a SAVE command, your data is available. By default, if you issue the 
SAVE command without storing PID0, the data is stored to PID1. Depending on 
which PID is in the working area when you issue the SAVE command, the PID 
will be loaded the next time you boot the camera.

PID 0 is the current PID info being used.

PID 99 is the default PID information used to start from factory defaults.

There are options and configurations available to advanced users.

ASSIGN {pid#} {trigger#}

You can ASSIGN {pid#} to {trigger#}. Because there are 28 real/virtual triggers, 
you can program the camera to “trigger” and indicate that a specific symbol is in 
the field of view and ready to be decoded. The camera pre-loads the decoder with 

TABLE 1–13. Parameters Stored in Each PID

Parameter Notes

Photometry Gain & Exposure only. NOTE: If Autophotometry is ON 
(System parameters), then these PID settings are NOT 
used.

PreProcessing Morphology operator and iterations

Decoder All decoder parameters.
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the specific parameters for that product as the image is being lifted. When the 
image is in RAM, the “learned” parameters are used to rapidly and accurately 
decode the image. Thus, several “learned” products can be used on the same line 
without stopping and re-programming the camera.

VIEW PID {pid#}

You can VIEW PID {pid#} to validate what you have stored.

LOAD PID {pid#}

If you do not want to use multiple PIDs, you can LOAD PID {pid#} into the 
current parameters and any trigger will use those parameters.
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POLARITY

Description
This command sets expected polarity of the Data Matrix.

Syntax
POLARITY {opt}

Where:

opt — Is one of the following:

– AUTO (default)

– DL — Dark on light

– LD — Light on dark
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POSITION_ENHANCE_ENABLED
See “FINETUNE” on page 1-54.
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PROBE DIRECTION

Description
This command sets the Probe direction.

Syntax
PROBE DIRECTION {opt}

Where:

opt — Is one of the following:

– HORI(zontal)

– HORI_VERT (default)

– VERT(ical)

– VERT_HORI

– CRISS_CROSS
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PROBE SPEED

Description
This command sets the Probe speed.

Caution: Increasing the probe speed may adversely affect the robustness of 
the reading.

Syntax
PROBE SPEED {opt}

Where:

opt — Is one of the following:

– NORMAL (default)

– OVERDRIVE

– TURBO
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PROBE THRESHOLD

Description
This command sets the Probe threshold level that the edge should exceed.

Syntax
PROBE THRESHOLD {opt}

Where:

opt — Is the probe threshold level:

Range: 5 - 100
Default: 18
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PROMPT

Description
This command controls the user-defined command prompt.

Syntax
PROMPT {opt} [""prompt string""]

Where:

opt — Is either of the following:

ON
OFF (default)

prompt string — Up to a 40-character prompt string. The default is > . The string 
may include control characters by preceding the control char with ’\’, and 
followed by two hex characters. For example:

""\07"" for bell

""\\"" for a backslash character
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QRFINDER

Description
This command sets the QR finder misalignment parameter.

Syntax
QRFINDER {opt}

Where:

opt — Is one of the following:

– 0 — QR_FINDER_SHIFT_NONE (default)

– 1 — QR_FINDER_SHIFT_IN1

– 2 — QR_FINDER_SHIFT_IN2

– 3 — QR_FINDER_SHIFT_IN3

– 4 — QR_FINDER_SHIFT_OUT1

– 5 — QR_FINDER_SHIFT_OUT2

– 6 — QR_FINDER_SHIFT_OUT3
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QUICSET

Description
QuicSet® provides audible and visual feedback about the optical alignment of 
the camera and the symbol positioned under it. QuicSet® also determines the 
correct Gain and Exposure settings for the symbol.

To enter QuicSet® mode, press the recessed QuicSet button once.

Note: The QuicSet® button is located on the connector side of the camera, which 
is opposite the lens side. You will need a paper clip.

The yellow Mode LED should start flashing. Physically position the camera 
above the symbol. You will hear a series of beeps. The beeps have three tones:

• Lowest Tone — Symbol is in the field of view

• Middle Tone — Symbol is close to being in the optimal read position

• Highest Tone — Symbol is in optimal read position

The LEDs on the front of the camera illuminate to indicate positioning:

• All LEDs on — Optimal setting

• Mode LED flashing — Poor symbol alignment

Move the camera until you hear the highest tone, and then lock down the camera.

To exit QuicSet®, press the QuicSet button once. You should hear three short 
beeps, and the Mode light should be steady on, indicating that the camera has 
stored the Gain and Exposure parameters. The camera is now online, running an 
application.

The QuicSet® feature is effective only if Photometry is set to manual.

You can initiate the LEARN and UNLEARN commands using the QuicSet 
button. In the Terminal window, type HELP LEARN V or HELP UNLEARN V 
for more information.

Syntax

• Run QuicSet®:
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QUICSET Y

• Cancel QuicSet®:

QUICSET N

• Display the current setting for QuicSet®:

QUICSET ?
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QUICSETPLUS

Description
This command allows you to specify what functions QuicSet® can perform.

Syntax
QUICSETPLUS {TrigPolDetect} {MatchStringDetect} {Allow Learn} 
{Allusive}

Where:

TrigPolDetect — (Y | N)

If Y, then the trigger polarity of the OPTO IN signal at the time of successful 
exit from QuicSet® is set automatically as the triggering “edge.”

The default is N.

MatchStringDetect — (Y | N)

If Y, then the data encoded in the symbol used for QuicSet® alignment is set 
automatically as the “match string.” For more information about match 
string, type HELP MATCH.

The default is N.

Allow Learn — (Y | N)

If Y, then allow Learn and Unlearn button presses while in QuicSet 
alignment.

The default is Y.

Allow Save — (Y | N)

If Y, automatically save all data to Flash after Learn or Unlearn. Otherwise, 
just RAM will be updated.

The default is Y.
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RATIO

Description
This command sets the expected width to height ratio. In READ mode, when 
HEIGHT and WIDTH are set to AUTO, RATIO can set the expected ratio. If the 
ratio may change, use RATIO AUTO. For a square Data Matrix, the ratio is 1.0, 
which means you should use RATIO 10.

Note: See also “HEIGHT” on page 1-58 and “WIDTH” on page 1-180.

Syntax
RATIO {opt}

Where:

opt — Is either of the following:

– ratio — Range: 3 - 50 (3 = 0.3; 50 = 5.0)

– AUTO — Autoselect (default)
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RELEASE

Description
This command releases control of the camera, allowing other users access to it.

Syntax
RELEASE
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REMOVE

Description
This command removes the assigned PID from the indicated trigger. When the 
specified trigger occurs, (to indicate the read and decode of an image), the default 
current PID parameters will be used by the decoder.

Syntax
REMOVE {trig}

Where:

trig — Is the trigger number:

Range: 0 - 27
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REPORTCANCEL

Description
This command cancels a pending REPORTREQ command. This command is 
only used by ReadRunner.

Syntax
REPORTCANCEL
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REPORTREQ

Description
This command retrieves the next report from the system while running. This 
command is only used by ReadRunner.

Syntax
REPORTREQ {opt1} {opt2} {opt3}

Where:

opt1 — Compression

0 — Lossless compression NOT IMPLEMENTED

1 — JPEG with quality value=1, 4:1 compression ratio

4 — JPEG with quality value=4, 8:1 compression ratio

26 — Decimated image with JPEG quality=2, 16:1 compression ratio

27 — Decimated image with JPEG quality=5, 32:1 compression ratio

255 — No compression applies; image uploaded in full

NONE — No compression applies; image uploaded in full (DEFAULT)

opt2 — Is either 0 (keep image out) or 1 (include image)

opt3 — NEXTFAIL or LASTFAIL — Retrieves the next failed or last failed 
report. If not specified, retrieves the next report.
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RESET

Description
This command reset some or all settings and, in some cases, reboots the unit.

Syntax
RESET [opt]

Where:

opt — Is one of the following:

– ALL — Performs a RESET FACTORY, saves it to Flash, and then 
reboots the unit.

– APPMODE — Reset the acquisition parameters and lighting 
(essentially everything in the Application Mode dialog of ReadRunner) 
and save it to flash.

– DECODER — Reset the decoder to factory defaults, reset photometry 
to Auto, and save it to flash.

– HARD — Reboot the unit.

– FACTORY — Reset all settings to factory defaults. This includes all 
connectivity options. The camera will be set to DHCP Y, the camera 
name will be set to “HawkEye” (where xxyyzz are the last three octets 
of the camera’s MAC address), default IP address, CONSOLE 0, BEEP 
Y. All decoder parameters, acquisition parameters, and BOOT PARA 
MS (except for the MAC address) will be set to factory defaults. All will 
be save to flash.

– SOFT — This takes the camera offline (if necessary), performs the 
equivalent of RESET APPMODE and RESET DECODER, removes 
any saves PIDs as seen with the DIR command, and then restores the 
starting offline status. No changes are made to the BOOT PARAMS and 
the camera is not rebooted.
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RETRY

Description
This command sets the retry mode, which allows the reader to try different 
decoder or light parameters, as well as to try multiple image captures.

Syntax

• Set read cycle to single attempt mode with no retries on failure. This is the 
default:

RETRY NONE

• Set read cycle to multiple retry attempts within the specified time limit:

RETRY TIME opt

Where:

opt — Is 35 - 60000ms

• Set read cycle to a specified number of attempts:

RETRY COUNT opt

Where:

opt — Is 1 - 15

• Report only successful attempts. If duplicate data occurs, report it only if opt 
ms have elapsed since last decode:

RETRY SUPERMARKET opt

Where:

opt — Is 0 - 60000ms; (0 = infinite ISWT)

• While the GPIO signal is present on Pin 9, keep retrying:

RETRY GPIO

• Retry up to three PIDs if the first decode failed. You may define a list of up 
to three PIDs to be tried on decode failure. The decode occurs on the same 
image. The last PID used will be left as the current PID unless there is a PID 
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assigned to the trigger and, if so, the PID assigned to the trigger will be the 
next loaded and used:

RETRY LIST [pid# | pid# | pid#]

Where:

pid# — Is the PID number.

• Retry once using the specified lighting:

RETRY LIGHT {opt} {pid}

Where:

opt — Is one of the following:

• OFF — Use ambient lighting.

• ON — Use constant lighting; this is the default.

• EXTERNAL — Use external lighting.

• STROBE — Use strobe lighting.

• POWER[_STROBE] — Use power stobed lighting.

• ON_AND_PSTROBED — Constant on with power strobing 
at trigger.

pid — You may define a valid PID to be tried on decode failure. The gain 
and exposure from the indicated PID will be used only if the Photometry is 
set. This mode is used commonly with the internal lighting provided and on 
retry using an external light (user provided) usually with Dot Peen marks.
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RETRYEX

Description
This command sets the retry modes of the system for all modes. It is identical to 
the RETRY command; however, it is meant to be used by custom FBI or C++ 
code and requires all fields to be specified. In addition, RETRYEX can be 
queried. ReadRunner uses RETRYEX to program all the retry modes in the 
camera. RETRY is meant to be used instead by a user typing the command 
manually in the Terminal Window or Hypercritical program.

Note: Each field must contain valid information regardless of the mode you 
select.

Syntax

• Set read cycle to single attempt mode with no retries on failure. This is the 
default:

RETRY NONE

• Set read cycle to multiple attempts within the specified time limit:

RETRY TIME opt

Where:

opt — Is 35 - 60000ms

• Set read cycle to a specified number of attempts:

RETRY COUNT opt

Where:

opt — Is 1 - 15

• Report only successful attempts. If duplicate data occurs, report it only if opt 
ms have elapsed since last decode:

RETRY SUPERMARKET opt

Where:
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opt — Is 35 - 60000ms

• While the GPIO signal is present on Pin 9, keep retrying:

RETRY GPIO

• Retry up to three PIDs if the first decode failed. You may define a list of up 
to three PIDs to be tried on decode failure. The decode occurs on the same 
image. The last PID used will be left as the current PID unless there is a PID 
assigned to the trigger and, if so, the PID assigned to the trigger will be the 
next loaded and used:

RETRY LIST [pid# | pid# | pid#]

Where:

pid# — Is the PID number.

• Retry once using the specified lighting:

RETRY LIGHT {opt} {pid}

Where:

opt — Is one of the following:

• OFF — Use ambient lighting.

• ON — Use constant lighting; this is the default.

• EXTERNAL — Use external lighting.

• STROBE — Use strobe lighting.

• POWER[_STROBE] — Use power stobed lighting.

• ON_AND_PSTROBED — Constant on with power strobing 
at trigger.

pid — You may define a valid PID to be tried on decode failure. The gain 
and exposure from the indicated PID will be used only if the Photometry is 
set. This mode is used commonly with the internal lighting provided and on 
retry using an external light (user provided), usually with Dot Peen marks.
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ROI

Description
This command defines the region of interest (ROI) for the symbol.

Syntax

• Define the coordinates of the region of interest:

ROI {ux, uy, lx, ly}

Where:

– ux — 0 - 658 (658 = default); u corresponds to upper left

– uy — 0 - 493 (493 = default); u corresponds to upper left

– lx — 0 - 658 (0 = default); l corresponds to lower right

– ly — 0 - 493 (0 = default); 1 corresponds to lower right

• Define the region of interest based on the most recently decoded Data 
Matrix:

ROI AUTO {pad}

Where:

pad — Is one of the following:

– 1 — 50 pixels larger than the Data Matrix

– 2 — 100 pixels larger than the Data Matrix

– 3 — 150 pixels larger than the Data Matrix

– 4 — 200 pixels larger than the Data Matrix

• Reset the region of interest back to the original area (full ROI):

ROI RESET
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ROWS

Description
This command specifies the number of rows to expect in the Data Matrix symbol. 
The algorithm uses the value specified without having to re-compute it from 
image to image.

Note: See also “COLS” on page 1-37.

Syntax
ROWS {opt}

Where:

opt — Is either of the following:

– rows — Is the number of rows:

Range: 8 - 144

– AUTO — Autoselect (default)
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RTE

Description
This command customizes the overrun message output of the HawkEye™ 1500. 
This command only affects the STANDARD output. See “OUTPUT” on 
page 1-99 for more details.

Syntax
RTE {cntrl} [""string""] [{Hdrcntrl} {Trlcntrl} {Beepcntrl}]

Where:

cntrl — Is the RTE message active (Y or N)?

string — (1 - 39 characters); the string may include keyword substitution:

– CHECKSUM — This keyword expands to the checksum of the 
characters in the appropriate Output Format String where the 
(CHECKSUM) keyword is inserted. The two character ASCII value 
representation of the Hexadecimal checksum (for example, 2E) is 
substituted in the Output string. The checksum is calculated as the 
Exclusive OR (XOR) of all the characters up to the (CHECKSUM) 
keyword, including the Header and the Trailer characters if 
(CHECKSUM) is placed at the end of the trailer string.

– TIMESTAMP — This keyword will be substituted with the current date 
and time.

Note: The following parameters are optional. However, it you enter one of them, 
you must enter all of them at the same time.

Hdrcntrl — Print the header before the RTE string (Y or N)?

Trlcntrl — Print the trailer before the RTE string (Y or N)?

Beepcntrl — Sound this many beeps (0 - 3) when this report is issued. The 
default is 0.
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RUN_SETTINGS

Description
This command runs the factory set commands without resetting customer tuning.

Syntax
RUN_SETTINGS {opt}

Where:

opt — Is one of the following:

– BOTH — Run the factory installed command sequences seen in the 
Hardware Settings and Customer Settings of the Settings window.

– CUSTOMER — Run the factory installed command sequences seen in 
the Customer Settings of the Settings window.

– FACTORY — Run the factory installed command sequences seen in the 
Hardware Settings of the Settings window.

Displaying the Settings Window
Use the following procedure to display the Settings window:

1. In ReadRunner, click Add Camera.

2. Highlight a camera name and click OK.

3. Click (to select) the camera button for the camera you just added.

4. From the Help menu, click About ReadRunner.

5. Click Details.

ReadRunner displays a screen similar to the one in Figure 1–1.
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FIGURE 1–1. Settings Window

• Hardware Settings Installed in Manufacturing — These settings depend on 
the hardware purchased by the customer.

• Customer Settings Installed in Manufacturing — These settings depend on 
the customer’s specifications.

• Manufacturing Data — These are such things as MAC address, serial 
numbers, and so on.

RUN_SETTINGS FACTORY

RUN_SETTINGS CUSTOMER

RUN_SETTINGS BOTH

restores these settings

restores these settings

restores these settings
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SAVE

Description
This command saves the current configuration (regardless of boot option).

Syntax
SAVE {opt}

Where:

opt — Is either of the following:

– BOOT — Load the job on boot. This is the default.

– NOBOOT — Clear the BOOT option.
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SET_CRITERIA

Description
This command allows criteria for variable testing to be configured for the 
IOASSIGN command.

Syntax
SET_CRITERIA {variable_name} {Type} {arg1} {arg2}

Where:

variable_name — The supported variable_names are:

– ANGLE_FAILURE

– LOCATE_FAILURE

– DECODE_FAILURE

– RTE

– PASS

– FAIL

– DV

– GOOD (reserved for verification option)

– FAIR (reserved for verification option)

– POOR (reserved for verification option)

– EXPRESSION1 (reserved for future use)

– EXPRESSION2 (reserved for future use)

Type — The supported Types are:

– BOOL

No arguments required

The contents of the variable_name is a Boolean data type determines 
ON/OFF states.
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– MASK

arg1 — bit_mask entered as a hex value like 0x200
arg2 is not required

The contents of the variable_name will be ANDed with the argument 
value to isolate a bit in a value; in other words, a particular bit in an 
error code could be used to trigger a digital output.

– NOMINAL_DEV

arg1 — a nominal value
arg2 — deviation from the nominal value

This tests the contents of a variable name to see if it is in the range of 
“Nominal +/- Deviation.” Use this type with ANGLE_FAILURE as 0° 
+/- 10° will be translated correctly, while MAX_MIN will reject any 
entered Minimum greater than the entered Maximum.

– MAX_MIN

arg1 — maximum value
arg2 — minimum value

This tests the contents of a variable name to see if
“Minimum < value < Maximum.”

INPUT_POS — Trigger edge directions

INPUT_NEG

INPUT_BOTH

For the 3 Input Types:

arg1 — The delay (0 - 10000ms) before performing the trigger.

arg2 — The latch time (0 - 10000ms) to wait for the line to become 
stable.

– EXPR — (Reserved for future use)

Note: Only integer value are supported.
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SET_LICENSE

Description
This command allows you to enter manually a license key to enable Options.

Note: Licenses only activate the desired Option on the camera for which it was 
issued. Double check that the Serial Numbers match.

For example:

SET_LICENSE D8R3Z-6UUV4-3SXTM-K7LB6-D5GT9 

Syntax
SET_LICENSE {key string}
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SHOW

Description
This command shows a group of current settings based on category.

Syntax

• Show current values of all commands in a job:

SHOW ALL

• Show current values of specific commands in a specific job:

SHOW {cat} {job}

Where:

cat — 3 — Serial Reporting commands

4 — System Configuration commands

5 — Communication Related commands

job — 0 — Current settings (default)

1 — Saved job

99 — Factory defaults.

• Show current values of commands in a PID:

SHOW {cat} [pid]

cat — 6 — Fine Tuning Symbology/Decoder

pid — 0 - 15, 99
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SIGOUT

Description
This command sets the polarity for the I/O lines.

Syntax
SIGOUT {name} {level}

Where:

name — Is one of the following:

– OPTO_OUT1

– OPTO_OUT2

– OPTO_OUT3

– GPIO_OUT1

– GPIO_OUT2

– GPIO_OUT3

– GPIO_OUT4

level — Is the level:

– H — high

– L — low
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STATS

Description
This command tracks reading statistics.

Syntax

• Display the current statistics (this is the default):

STATS ?

• Reset the statistics:

STATS RESET
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STORE

Description
This command stores all parameters associated with decoding a symbol. The 
STORE command can store up to 15 learned symbols.

Notes: You must issue the SAVE command to store all 15 PIDs to Flash.

The STORE command overwrites any saved parameters previously saved with 
the STORE command.

Syntax
STORE {pid#}

Where:

pid# — Is the PID number:

Range: 1 - 15
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STYLE

Description
This command selects whether the Data Matrix symbol is viewed as if through a 
mirror or direct.

Syntax
STYLE {style}

Where:

style — Is one of the following:

– AUTO

– MIRROR

– NORMAL (default)
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TARGET

Description
This command turns the Target Laser on or off.

Syntax
TARGET {opt}

Where:

opt — Is either of the following:

– ON (default)

– OFF

– T — Turn on laser for two seconds after acquisition.
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TBL

Description
This command sets the opto isolated input trigger’s bounce latch time.

Note: See also “TD” on page 1-154 and “TE” on page 1-155.

Syntax
TBL {time}

Where:

time — Is the bounce latch time:

Range: 0 - 10000ms
Default: 20ms
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TD

Description
This command sets the opto isolated input trigger’s interrupt detection delay.

Note: See also “TBL” on page 1-153 also “TE” on page 1-155.

Syntax
TD {delay}

Where:

delay — Is the delay:

Range: 0 - 10000ms
Default: 0ms
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TE

Description
This command sets the opto isolated input trigger’s edge direction.

Note: See also “TBL” on page 1-153 and “TD” on page 1-154.

Syntax
TE {direction}

Where:

direction — Is one of the following:

– B — Both

– N — Negative (default)

– P — Positive
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TERMINAL ECHO

Description
This command enables/disables echoing of typed data.

Syntax
TERMINAL ECHO {opt}

Where:

opt — Is either of the following:

– ON

– OFF (default)
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THRESHOLD

Description
This command selects the threshold method in binarizing.

Syntax
THRES{HOLD} {opt}

Where:

opt — Is one of the following methods:

– GLOBAL — Should always be used unless it produces excessive 
SYMBOL_UNDECODABLE

– LOCAL — Effective if Data Matrix cells are not printed with equal 
space

– ADAPTIVE — Effective when the Data Matrix area has uneven 
background

The default is:

THRES:Global, Local, Adaptive

or

Global+Local+Adaptive
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TIME

Description
This command displays current time in the unit.

Syntax

• Display the current time in hex:

TIME ?

• Display the current time in seconds, since THU JAN 01 00:00:00 1970. This 
message sets the time in the HawkEye™ 1500 for time stamping of images:

TIME
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TIMEOUT

Description
This command limits the time spent in the algorithm trying to inspect/decode the 
symbol just lifted.

Caution: Only an Applications Engineer trained in systems use should 
change this parameter.

Another method to limit the time spent in the algorithm is to turn off all 2-D 
symbologies if the parts being read are always 1-D.

Syntax
TIMEOUT {READ | EDAC}

Where:

READ — 0 - 9999ms; default is 600ms

EDAC — 0 - 9999ms; default is 45ms
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TIMESYNC

Description
This command uses the SNTP server to synchronize local time on the camera 
(per RFC 868).

Syntax
TIMESYNC {interval} [server]

Where:

interval — Interval (in seconds) to query for time

server — Name of time server
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TRAILER

Description
This command sets the Report Trailer to the indicated string. Use TRAILER to 
“follow” the decode output with text. For example, to prompt the user for the 
next read:

TRAILER “Next item:”

The fourth option of the following commands determines whether or not the 
trailer is printed:

• BATCHFL

• DECFL

• LOCFL

• MATCHFL

• OKDEC

• OKMATCH

• RTE

Syntax
TRAILER {string}

Where:

string — (1 to 80 characters); the string may include control characters by 
preceding the control char with ’\’, and followed by two hex characters. For 
example:

""\07"" for bell

""\\"" for a backslash character

The string may include keyword substitution:

– CHECKSUM — This keyword expands to the checksum of the 
characters in the appropriate Output Format String where the 
(CHECKSUM) keyword is inserted. The two character ASCII value 
Rev 2.2.1, Jul. 2006 HawkEye 1500 Series Reference & Programmers Manual 1-161



Chapter 1 Remote Commands Reference
representation of the Hexadecimal checksum (for example, 2E) is 
substituted in the Output string. The checksum is calculated as the 
Exclusive OR (XOR) of all the characters up to the (CHECKSUM) 
keyword, including the Header and the Trailer characters if 
(CHECKSUM) is placed at the end of the trailer string.

– TIMESTAMP — This keyword will be substituted with the current date 
and time.
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TRIG{GER}

Description
This command sets the triggering mode of the HawkEye™ 1500.

Syntax

• Set triggering mode to continuous read:

TRIG C

• Set triggering mode to read only when triggered:

TRIG T

• Enter a character string to signal a virtual trigger:

TRIG U <chars>

Where:

chars — Is the set of printable characters to be used as the virtual trigger. 
You can define up to five printable characters. This “string” trigger can be 
sent over serial or the ASCII PLC TCP/IP connection port.

Note: TRIG U with no string specified sets the trigger string to a space 
character “ “. This is the default trigger character.
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TRIGTABLE

Description
This command alters the dynamics of hardware lines, and configures virtual 
triggers.

Note: I/O management of Physical INPUT and OUTPUT lines is now done with 
SET_CRITERIA and IOASSIGN commands. To prevent the TRIGTABLE 
commands from causing conflicts, TRIGTABLE is no longer allowed to work on 
trigger numbers 3, 4, 5, and 6.

To alter the dynamics of an actual hardware line:

• Any hardware line that can cause an interrupt (including the QuicSet® 
button) can have the polarity, latch and delay modified using the 
TRIGTABLE command. Use the following trigger number on the 
HawkEye™ 1500:

– 2 — Opto Isolated Trigger Input

• There are also several GP outputs that indicate read results. These are 
marked as outputs. The Edge options on these outputs are valid only for 
those outputs and have no effect on inputs since they are virtual. Use the 
following trigger numbers on the HawkEye™ 1500 to affect just the output 
edges:

– 12 — Opto Isolated Output 1

– 13 — Opto Isolated Output 2

– 14 — Opto Isolated Output 3

– 16 — General Purpose Output 2

– 17 — General Purpose Output 3

– 18 — General Purpose Output 4

To program the functionality of a physical or virtual trigger:
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• Each of the 28 triggers can trigger the unit. The Opto Isolated trigger is 
automatically wired into the unit and will be used primarily to cause physical 
trigger inputs to the system.

• The General Purpose inputs can be wired to the external connector (see the 
HawkEye™ 1500 Series User Manual) to also cause real interrupts. All of 
the other trigger numbers can be used as virtual triggers. The user or GUI 
simply needs to send the command “VT #” and the unit will respond as 
though an actual interrupt occurred.

Syntax

• Enable or disable the following triggers for initiating a Decode sequence:

TRIGTABLE {opt1} {opt2}

Where:

opt1 — 0 - 27 or GPIO

opt2 — Is either ENABLE or DISABLE

If GPIO is enabled, then when an Opto Isolated Sensor Input trigger occurs, 
the three GPIO input lines 2, 3, 4 are read to determine a VT # to occur.

• Set trigger latch time (debounce) in milliseconds:

TRIGTABLE {opt1} LATCH {opt3}

Where:

opt1 — Is the trigger number (2, 9)

opt3 — Is the time in milliseconds (0 - 1000)

• Set delay from trigger to recognition of trigger in milliseconds:

TRIGTABLE {opt1} DELAY {opt3}

Where:

opt1 — Is the trigger number (2, 9)

opt3 — Is the time in milliseconds (0 - 1000)

• Set trigger edge detection Positive or Negative:
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TRIGTABLE {opt1} EDGE {opt3}

Where:

opt1 — Is the trigger number (2, 9)

opt3 — Is the edge (POSITIVE or NEGATIVE)

• Set the functionality of the trigger to be a Read or Learn:

TRIGTABLE {opt1} {opt2}

Where:

opt1 — Is the trigger number (0 - 27)

opt2 — Is either READ (default) or LEARN
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TTY

Description
This command sets multiple TTY settings.

Syntax
TTY [baud] [parity] [databits] [stopbits] [flowcontrol]

Where:

Baud — 600 - 256000bps

parity — O or E or None

databits — 7 or 8

stopbits — 1 or 2

flowcontrol — Is one of the following:

– N — None

– H — Hardware

– X — XonXoff
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UNLEARN

Description
This command opens up the decoder to read a wide variety of symbols. You can 
change this configuration using the LEARN command.

You can also issue an UNLEARN command using QuicSet®:

1. Assuming you are in QuicSet® mode, press and hold the QuicSet® recessed 
button for three to four seconds. This will perform an “unlearn” on the next 
acquired image.

Note: See also “LEARN” on page 1-68 and “LEARNASSIST” on page 1-69.

Syntax
UNLEARN
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VERENABLE

Description
This command allows you to select DPM verification parameters with optional 
Grade Ranges.

Syntax
VERENABLE {param} {Y | N} [{A | B | C | D} {B | C | D}]

Where:

param — Is one of the following:

1. VERENABLE CS {Y | N} 

Use Y or N to enable or disable cell size (CS) verification. The grade for CS 
is:

A if CS >= 10
B if CS >= 9
C if CS >= 7
D if CS >=5
F if CS < 5

2. VERENABLE CO {Y | N} 

Use Y or N to enable or disable Center Offset (CO) verification. The grade 
for CO is:

A if CO <= 2.5
B if CO <= 5
C if CO <= 7.5
D if CO <= 10
F if CO > 10

3. VERENABLE SO {Y | N}

Use Y or N to enable or disable Size Offset (SO) verification. The grade for 
SO is:

A if SO <= 2.5
B if SO <= 5
C if SO <= 7.5
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D if SO <= 10
F if SO > 10

4. VERENABLE CM {Y | N}

Use Y or N to enable or disable Cell Modulation (CM) verification. The 
grade for CM is:

A if CM >= 90
B if CM >= 80
C if CM >= 70
D if CM >= 60
F if CM < 60

5. VERENABLE BM {Y | N}

Use Y or N to enable or disable Border Match (BM) verification. The grade 
for BM is:

A if BM >= 95
B if BM >= 90
C if BM >= 85
D if BM >= 80
F if BM < 80

6. VERENABLE SC {Y | N}

Use Y or N to enable or disable Symbol Contrast (SC) verification. The 
grade for SC is:

A if BM >= 70
B if BM >= 55
C if BM >= 40
D if BM >= 20
F if BM < 20

7. VERENABLE AN {Y | N}

Use Y or N to enable or disable Axial Nonuniformity (AN) verification. The 
grade from AN is:

A if AN <= 6
B if AN <= 8
C if AN <= 10
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D if AN <= 12
F if AN > 12

8. VERENABLE PG {Y | N}

Use Y or N to enable or disable Print Growth (PG) verification. The grade 
for PG is:

A if -15 <= PG <= 15
B if -21 <= PG <= 21
C if -26 <= PG <= 26
D if -30 <= PG <= 30
F if PG > 30 or PG < -30

9. VERENABLE UEC {Y | N}

Use Y or N to enable or disable Unused Error Correction (UEC) verification. 
The grade for UEC is:

A if UEC >= 62
B if UEC >= 50
C if UEC >= 37
D if UEC >= 25
F if UEC < 25

10. VERENABLE AD {Y | N} 

Use Y or N to enable or disable Angle of Distortion (AD) verification. The 
grade for AD is: 

A if -2 <= AD <= 2
B if -4 <= AD <= 4
C if -6 <= AD <= 6
D if -7 <= AD <= 7
F if AD > 7 or AD < -7
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VERIFY

Description
This command turns on/off AIM verification. The AIM symbol quality 
parameters contain Symbol Contrast, Print Growth, Axial Nonuniformity, and 
Unused Error Correction (UEC). You must have one of the following keywords 
specified in the OKDEC output string to receive the verification results.

You must have one of the following keywords specified in the OKDEC output 
string:

• (VERI_DETAIL) — Detailed verification data, separated by semicolons 
(“;”), but only when Verification is enabled. This data includes the overall 
grade, grade contrast, contrast, grade axial number, AIM axial non- 
uniformity value, grade print growth, print growth value in X, print growth 
value in Y (1 for 100% and 0.35 for 35%, etc.), grade error correction, 
number of error bits, and the UEC value.

• The AIM Print Growth grade converted to HawkEye™ 1500 serial’s Print 
Growth Percentage (PGP) is:

– A(4) when -15% <= PGP <= 15%

– B(3) when -21% <= PGP <= 21%

– C(2) when -25% <= PGP <= 25%

– D(1) when -30% <= PGP <= 30%

– F(0) when PGP < -30% or PGP> 30%

• (VERI_FORMATTED) - Formatted verification data. This is similar to 
VERI_DETAIL, but each value is identified by an acronym title and is 
separated by spaces. 

• (VERI_GRADE) - Overall verification grade as a number, but only when 
Verification is enabled. 

Example
A Data Matrix with the following information:

Matrix size: 20x20 with 22 data codewords and 18 error correction codewords
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Encode data: HE1500

Symbol quality: Contrast 62%
Print Growth Percentage in X -13%
Print Growth Percentage in Y 24%
Axial Nonuniformity 0.07
UEC 11% (8 bits / 1 codeword)

Verification results output:

1. With command line OKDEC Y “(DATA);(VERI_DETAIL)\0d\0a” or set the 
ReadRunner output setting with (DATA);(VERI_DETAIL)\0d\0a in the 
decode pass area.

HE1500;3;3;62;4;0.07;2;0.13;0.24;4;8;0.11

2. With command line OKDEC Y “(DATA);(VERI_FORMATTED)\0d\0a” or 
set the ReadRunner output setting with 
(DATA);(VERI_FORMATTED)\0d\0a in the decode pass area.

HE1500;OG:3 CG:3 C:62 nG:4 n:0.07 PGP:2 PGx:0.13 PGy:0.24 GUEC:4 
B#: 8;0.11

3. With command line OKDEC Y “(DATA);(VERI_GRADE)\0d\0a” or set the 
ReadRunner output setting with (DATA);(VERI_GRADE)\0d\0a in the 
decode pass area.

Syntax
VERIFY {none | AIM

Where:

None — Disables verification

AIM — Enables AIM verification

Additional Verification Options
If you purchased the verification option for your HawkEye™ 1500 camera, 
additional verification modes are available:

VERIFY {none | AIM | IAQG | ISO | ISO AIM | DPM | ANSI

• VERI_STATUS — Report the verification status (see “VERSTATUS” on 
page 1-176). VERI_STATUS is reported as 3 = Good, 2 = Fair, 1 = Poor.
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• VERI_GRADE — Report the overall grade as A = 4, B = 3, C = 2, D = 1, or 
F = 0.

• VERI_DETAIL — Report parameters and/or grades in a semicolon 
delimited string.

• VERI_FORMATTED — Same as VERI_DETAIL except each parameter is 
pre-pended with its name.

DPM — The DPM verification always measures and reports 10 different 
parameters and their grades. Each grade is reported as 4 = A, 3 = B, 2 = C, 1 = D, 
and 0 = F. You have the option to enable all or a subset of the 10 parameters for 
determining the overall grade. The overall grade is the lowest grade received by 
all enabled verification parameters.

• VERI_STATUS — Report the verification status (see “VERSTATUS” on 
page 1-176).

• VERI_GRADE — Report the overall grade as A, B, C, D, or F.

• VERI_DETAIL — All parameters (enabled or not) and their grades are 
reported.

• VERI_FORMATTED — Same as VERI_DETAIL except each parameter is 
pre-pended with its name.

See the HawkEye™ 1500 Series Verification Manual for additional details for 
each of the optional verification types.
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VERSION

Description
This command lists the current version of the software.

Syntax
VER{SION}
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VERSTATUS

Description
This command selects the verification grade ranges. The verification status 
indicates whether a Data Matrix mark is good (2), fair (1), or poor (0), based on 
the overall grade and two threshold values set using the command.

The grades grade1 and grade2 are threshold values for good and fair marks, 
respectively. The valid values for grade1 and grade2 are A, B, C, or D. The value 
grade1 can be higher than or equal to but not lower than the value grade2. 

For example, the command:

VERSTATUS B D

configures the reader to report verification status to be 2 for grade A or B, 1 for 
grade C or D, and 0 for grade F.

Syntax
VERSTATUS {param1} {param2}

Where:

param1 — Is A, B, C, D

– This parameter is the lowest grade considered Good

param2 — Is B, C, D

– This parameter is the lowest grade considered Fair. Param2 can never be 
greater than param1. If param2 = param1, verification will only give 
Good and Poor results, since there is no range of grades for Fair.
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VIEW

Description
This command displays the stored values in the PID index.

Syntax
VIEW {pid#}

Where:

pid# — Is one of the following:

– 0 — Current working area (default)

– 1 - 15

– 99 — Factory defaults
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VT

Description
This command causes a Virtual Trigger to occur (the application must be waiting 
for it).

Syntax
VT {trigger}

Where:

trigger — Is the trigger number:

Range: 0 - 27

Note: Triggers numbered 2, 4, 5, & 6 are actual GPIO lines and are considered 
physical; the remaining triggers are considered virtual.
1-178 HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006



WARP

R
em

o
te

 C
o

m
m

an
d

s 
R

ef
er

en
ce

1

WARP

Description
This command sets the matrix warping speed. Typically, Fast produces 
satisfactory read rates with much higher speed, although Slow sometimes can be 
more robust than Fast for very poor images.

Syntax
WARP {opt}

Where:

opt — Is either of the following:

– Fast (default)

– Slow
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WIDTH

Description
This command sets the expected Data Matrix width.

Note: See also “HEIGHT” on page 1-58 and “RATIO” on page 1-128.

Syntax
WIDTH {opt}

Where:

opt — Is either of the following:

– width — Is the width:

Range: 20 - 1024

– AUTO — Autoselect (default)
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CHAPTER 2 ReadRunner Programming 
Reference

Introduction
The ReadRunner development libraries allow for easy development of custom 
applications that interface to the HawkEye™ 1500 family of readers. A unique 
approach, described herein, significantly simplifies user programming – yet 
provides maximum flexibility. The key concept that facilitates this simplicity is 
an object called the MiCoordinator. The MiCoordinator object allows the various 
components to “talk” to each other behind the scenes – so that, in most cases, the 
amount of custom code that needs to be written is surprisingly small.

Libraries
There are three libraries that contain components of interest:

• MIOBJ.DLL – (Siemens HawkEye™ Reader Object Type Library) This 
library contains lower level objects that provide the foundation for the other 
libraries. The MiCoordinator object mentioned above resides here, as well as 
the MiCycleReport object, which wraps data (reports and images) coming 
from a HawkEye™ 1500 reader. This library also contains objects that 
manage connections to HawkEye™ 1500 devices. In most cases, you will 
not have to deal with these connection objects directly, as these are, in turn, 
wrapped in even easier to use objects.
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• MIOBJUI.DLL – (Siemens HawkEye™ Reader ActiveX Library) This 
library contains several user interface objects. The most important object in 
this library is MiImageView, which provides an easy way of viewing images 
that come from a HawkEye™ 1500.

• RRKIT.OCX – (Siemens ReadRunner ActiveX Library) This library 
provides many useful user interface and connection objects. This will likely 
be the starting point for any custom-programming project. The library itself 
is written in Visual Basic, which illustrates the depth available to the 
programmer.

Note: To include these libraries in a VB project, first include MIOBJ.DLL as a 
Project Reference, and then add MIOBJUI.DLL and RRKIT.OCX as Project 
Components.

Important Objects

• MiCoordinator — This object provides the foundation on which most of the 
other objects rely. Even if you do not use this object directly, understanding 
what is does will provide a better understanding of the other components.

– Provides behind the scenes magic glue. In fact, all instances of the 
MiCoordinator object within the same process are actually the exact 
same object. To illustrate, imagine two forms, each declaring their 
“own” new MiCoordinator object. Since they are both actually the same 
object, one control can call a method of its “own” MiCoordinator, which 
results in an event to the clients of all MiCoordinators.

– Maintains list of discovered devices (HawkEye™ 1500’s). This list is 
provided via the Devices property. For example, in VB, you could do 
the following:

dim coord as new MiCoordinator

Dim d as MiDevice

for each d in coord.Devices

‘ do something with device

next d

– Provides concept of “Focus Device”. In many cases, an application is 
only concerned with a single device at a time. When this is the case, the 
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device to work with can be specified using the DeviceFocusSet method 
of the MiCoordinator. This, in turn, will cause the OnDeviceFocus 
message to be sent to every other MiCoordinator object within the same 
process. Note that this does not actually make a connection. However, 
the ImageConnection and ReportConnection objects, as well as some of 
the user interface objects, use a MiCoordinator and make their 
connections as a result of receiving the OnDeviceFocus event.

– Provides general message broadcasting. The “magic glue” property of 
the MiCoordinator also can come in handy for applications that simply 
want to send a general message to other MiCoordinator users. Calling 
the BroadcastMessage method allows you to send a message string to all 
other MiCoordinator users, who will receive it via the 
OnBroadcastMessage event.

• MiASCIIConnection, MiImageConnection, and MiReportConnection 
— These objects represent low-level connections to a device. The 
MiASCIIConnection permits sending and receiving ASCII characters 
to/from a device, and is the only type of connection possible via a serial port. 
Using a MiASCIIConnection, images and reports are transferred using the 
XMODEM protocol. The MiImageConnection and MiReportConnection 
objects are for transferring images and reports using TCP over Ethernet.

Note: We recommended that you not use these connection objects directly, as 
they are wrapped within the easier to use connection objects described next.

• ImageConnection, ReportConnection — These objects wrap the low-level 
connections described above and make custom programming much easier. 
Most custom applications will start by declaring one or both of these objects. 
Each combines a MiASCIIConnection (to send/receive ASCII data such as 
commands), a MiCoordinator (so a connection can be established 
automatically to the focus device), and either a MiImageConnection or a 
MiReportConnection. It also abstracts the differences between serial and 
TCP based connections by using an ASCII protocol to transmit images over 
a serial port, and TCP if an Ethernet connection is available. It also provides 
some convenient properties to test the connection, such as IsConnected, 
IsSerial, etc. The lower level connections are also available as properties. 
Many of the events from the contained MiConnections, MiCoordinator, and 
the focus device, are reflected to the user. It is also possible to disable the 
auto-connect behavior of these controls.
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• MiCycleReport — After a connection is established, an OnNewRecord 
event is sent each time new data (image or report) is available. The 
parameter provided in this event is a MiCycleReport object. The same data 
type is provided in both image and report cases except that reports have an 
empty field for the image. There is a great deal of data provided in each 
MiCycleReport, including counters, pass/fail status, decoded data, timing 
information, photometry data, ROI data, etc.

• MiImageView — This control permits an easy way to view images 
contained in a MiCycleReport. It has options to display the decoded data and 
ROI as an overlay on the image. Multiple images can be displayed by 
enabling the Filmstrip Mode property. There is also the ability to overlay 
custom graphics and, in fact, you can even create and overlay custom 
draggable user interface objects with handles, such as an ROI.

• ReportGrid — A control that displays most of the data contained in a 
MiCycleReport in a spreadsheet format. You place this control directly on a 
form and then call its NewRecord method when you receive the 
OnNewRecord event from a connection.

• ReportChart — A control that displays timing and trend data from the 
MiCycleReport. You place this control directly on a form and then call its 
NewRecord method when you receive the OnNewRecord event from a 
connection.

• Terminal — This control automatically connects to the focus device and 
permits sending ASCII commands, much like a dumb terminal. It provides 
programmable buttons that can automatically send a series of commands 
when pressed.

• Application, AppSetting — Sending commands to a HawkEye™ 1500 is 
very straightforward simply by using the CommandSend method of an 
ImageConnection or ReportConnection. To query the state of most settings, 
you can send a command followed by a “?”. Often, it is the case that you 
might desire to query the state of a setting, change one thing (such as 
photometry gain while leaving the exposure alone) and send the command 
back with the change. You can use the Application object to make this logic 
easier to manage. The Application object provides methods for querying a 
setting and accessing the parameters individually. It is capable of querying 
any number of settings. When you write the settings back, only the settings 
that has actually changed will be written.
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Example 1 – A Simple Monitoring Application

Here’s an application that has an apparently challenging set of goals:

• Scan the network and enumerate all found HawkEye™ 1500’s in a 
dropdown box.

• Establish an image connection to the camera selected in the dropdown.

• Draw each image as received from the camera.

This application can be “written” by writing no code at all. Although the sample 
project is included, it’s worth the 3 minutes or less to walk through this example 
manually.

1. Open Visual Basic and create a new “Standard EXE” project.

2. Select Project->Components… and check the Siemens ReadRunner 
ActiveX Library (RRKIT.OCX). Notice the new component icons that 
appear in the component toolbar.

3. Select the CameraDropdown  component and place across the top of the 
form.

4. Select the ImageView  component and size to occupy the rest of the 
form.

5. You’re done. You can now run the application.

ImageView

CameraDropdown
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How This Works
The two components used in this application, CameraDropdown and ImageView, 
both use the MiCoordinator object. The CameraDropdown control first clears the 
Device List in the MiCoordinator, and then handles the OnDeviceDiscovered 
event, filling up the dropdown for each newly discovered camera on the network. 
When a device is selected via the dropdown, the DeviceFocusSet method is 
called with the name of the chosen device.

The ImageView control uses an ImageConnection, which will automatically 
establish a connection as a response to the Device Focus being set. Once the 
connection is established, each image will be received via the 
ImageConnection.OnNewRecord event. The MiCycleReport provided in this 
event is then passed to the MiImageView.NewRecord method, which will display 
the image and any overlay graphics.

Taking This Example Further
It is instructive to add some other controls to the current example.

1. Expand the dimensions of the form as much as possible to allow other 
controls to be placed on it.

2. Select the Cameras  control and position along the bottom of the form.

3. Select the Report Toolbar  and place on the form.

4. Select the Terminal  control and place on the form.
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5. You’re done. You may now run the application. You can send commands to 
the selected unit via the Terminal. The Cameras spreadsheet control shows 
detailed status of cameras on the network. The Report Toolbar shows some 
basic counters.

Summary
This example illustrates some of the power behind the ReadRunner development 
environment. Impressive capability is possible without even writing a line of 
code.

 Terminal Control 
 

Cameras 

Terminal 

Report Toolbar 
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Example 2 – Handling Images and Reports
In most cases, it is likely that the data coming from a connection to a HawkEye™ 
1500 will need to be manipulated in some way, perhaps simply to note pass/fail 
status, or perhaps to log data or images to a file. In this event, we will need to 
take control over some of the automatic functionality illustrated by the previous 
example. Even so, the programming is not at all difficult.

The goals of this example are:

• Establish two connections to an HawkEye™ 1500, one for images and one 
for reports.

• Update a text label with the decode string, and change the background color 
of the label to green for decode pass and red for decode fail.

• Update a displayed image – but only show failures.

This time, we will be using all three libraries. Again, although the sample code is 
included, it is worth the time to work through this example from scratch.

1. Create a new “Standard EXE” project.

2. Select Project->References… and check the Siemens HawkEye™ Reader 
Object Type Library (MIOBJ.DLL).

3. Select Project->Components… and check BOTH the Siemens 
ReadRunner ActiveX Library (RRKIT.OCX) and the Siemens HawkEye™ 
Reader ActiveX Library (MIOBJUI.DLL). Notice the new component icons 
that appear in the component toolbar.

4. Select the CameraDropdown  component and place across the top of the 
form.

5. Select a standard Label control and place on the form. In the VB properties 
window, change the BorderStyle for Label1 to “Fixed Single”.

6. Select the MiImageView  component and position on the form.

Note: This is NOT the same as the ImageView component we used in the 
previous example.

Here’s how the form should look:
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7. Now we’re going to have to write some code. Go to the Code window for 
Form1 (View->Code, or double click on the form). First declare, create, and 
cleanup the connections:

Option Explicit

' Declare connections WithEvents so we’ll receive events
Private WithEvents iconn As ImageConnection
Private WithEvents rconn As ReportConnection

Private Sub Form_Load()
    ' create the connection objects
    Set iconn = New ImageConection
    Set rconn = New ReportConnection
End Sub

Private Sub Form_Unload(Cancel As Integer)
    ' cleanup when exiting
    Set iconn = Nothing
    Set rconn = Nothing
End Sub
Rev 2.2.1, Jul. 2006 HawkEye 1500 Series Reference & Programmers Manual 2-9



Chapter 2 ReadRunner Programming Reference
8. Select the rconn object in the VB Object dropdown, and then select the 
OnNewRecord event (if this didn’t happen automatically). This will make an 
event handling subroutine for you to fill in. Enter the following code:

Private Sub rconn_OnNewRecord(ByVal objReport As 
MIOBJLib.IMiCycleReport)
    Label1 = objReport.ReportDecode.DecodeDataFormatted
    If objReport.Passed Then
        Label1.BackColor = vbGreen
    Else
        Label1.BackColor = vbRed
    End If
End Sub

9. Select the iconn object in the VB Object dropdown, and then select the 
OnNewRecord event. Enter the following code for the event handler:

Private Sub iconn_OnNewRecord(ByVal objReport As 
MIOBJLib.IMiCycleReport)
    ' only display failed images
     If Not objReport.Passed Then
            MiImageView1.NewRecord objReport
    End If
End Sub

10. You’re done. You can now run the project.

How This Works
By default, the ImageConnection and ReportConnection objects will 
automatically connect to the focus device as selected by the CameraDropdown. 
When the connections are established, OnNewRecord events are sent whenever 
there is new data available on the connection. The object passed as the parameter 
in this event is the MiCycleReport object – the same object is used for both 
images and reports. This object contains a great deal of detail about the 
completed cycle and is well worth browsing with the VB object browser. We use 
the DecodeDataFormatted field to fill the label with text, and the Passed Boolean 
to determine the label background color and to decide whether to display the 
image.

Taking This Example Further
When the “<no camera>” option is selected from the CameraDropdown – 
thereby disconnecting, we may want to clear the contents of the label as well as 
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the displayed image. This will illustrate how to do something when a connection 
status changes.

1. Select the rconn object in the VB Object dropdown, and then select the 
OnConnectionReset event. Enter the following code:

Private Sub rconn_OnConnectionReset()
    If Not rconn.IsConnected Then
        Label1 = ""
        Label1.BackColor = &H8000000F
        MiImageView1.ClearRecords
    End If
End Sub

Note: Although the report and image connections both raise the 
OnConnectionReset event, in this example, we can assume they are both 
connected to the same camera, so we can put the logic in only one place.

2. The OnConnectionReset event handler is a convenient place to put 
initialization logic. Therefore, call the event procedure directly from the 
Form_Load method:

Private Sub Form_Load()
    ' create the connection objects
    Set iconn = New ImageConection
    Set rconn = New ReportConnection

    ' call OnConnectionReset directly so
    ' initialization logic is all in one place
    rconn_OnConnectionReset
End Sub

3. Now, when you run the project, the image and label controls will be cleaned 
up as expected when you disconnect.
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Example 3 – Connecting to Two Cameras at Once
It is likely that most applications will only connect to a single camera at a time. 
Therefore, the default behavior simplifies this case. However, this behavior can 
be overridden, if necessary. Here is an example that connects to two cameras.

1. Create a new “Standard EXE” project.

2. Select Project->References… and check the Siemens HawkEye™ Reader 
Object Type Library (MIOBJ.DLL).

3. Select Project->Components… and check BOTH the Siemens 
ReadRunner ActiveX Library (RRKIT.OCX) and the Siemens HawkEye™ 
Reader ActiveX Library (MIOBJUI.DLL).

4. Select the CameraDropdown  component and place one stretching about 
half way across the top of the form. Then, select another one and place it 
next to the first one.

5. Select the MiImageView  component and position it below the first 
CameraDropdown. Then, add a second MiImageView control under the 
second CameraDropdown.
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6. Enter the code:

Option Explicit
Dim WithEvents m_cam1 As ImageConnection
Dim WithEvents m_cam2 As ImageConnection

Private Sub Form_Load()
    CameraDropdown1.AutoConnect = False
    CameraDropdown2.AutoConnect = False
    Set m_cam1 = New ImageConnection
    Set m_cam2 = New ImageConnection
    m_cam1.AutoConnect = False
    m_cam2.AutoConnect = False
End Sub

Private Sub Form_Unload(Cancel As Integer)
    m_cam1.DisconnectAll
    Set m_cam1 = Nothing
    Set m_cam2 = Nothing
End Sub

Private Sub CameraDropdown1_CameraSelected(selDevice As 
String)
   m_cam1.DeviceName = selDevice
End Sub

Private Sub CameraDropdown2_CameraSelected(selDevice As 
String)
    m_cam2.DeviceName = selDevice
End Sub

Private Sub m_cam1_OnNewRecord(ByVal objReport As 
MIOBJLib.IMiCycleReport)
    MiImageView1.NewRecord objReport
End Sub

Private Sub m_cam2_OnNewRecord(ByVal objReport As 
MIOBJLib.IMiCycleReport)
    MiImageView2.NewRecord objReport
End Sub

The key difference between this example and the previous ones is that the 
AutoConnect property of both CameraDropdowns and both 
ImageConnections are set to False. This means that we have to manually 
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handle what happens when a camera is selected in the dropdowns. You see 
how this is done via the CameraSelected event handlers. Setting the 
DeviceName property of an ImageConnection is all that is necessary to 
establish a connection to the named device. Since we have two connections, 
we also need to handle both OnNewRecord events and send the images to 
the corresponding MiImageView controls.

7. You’re done. You can run the project. It is even possible to make two 
separate connections to the same camera.
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Example 4 – Controlling the HawkEye™ 1500

This example will illustrate how to send commands to the HawkEye™ 1500. 
Any of the RRKIT.DLL connection objects (ReportConnection, 
ImageConnection, CommandConnection) have the capability to send commands 
to the connected device using the CommandSend() method. In this example, we 
will use an ImageConnection to do this, since we just happen to be displaying 
images as well. This example will also serve as an introduction to the Application 
and AppSetting objects. Here are the goals for this example:

• Establish a connection to a HawkEye™ 1500.

• Use a Checkbox control to switch between triggered and continuous 
acquisition modes.

• Send virtual triggers by way of a push button.

• Display images.

We will once again use the CameraDropdown to select a device. We start out 
with a variation of the previous example:

1. Create a new “Standard EXE” project.

2. Select Project->References… and check the Siemens HawkEye™ Reader 
Object Type Library (MIOBJ.DLL).

3. Select Project->Components… and check BOTH the Siemens 
ReadRunner ActiveX Library (RRKIT.OCX) and the Siemens HawkEye™ 
Reader ActiveX Library (MIOBJUI.DLL).

4. Select the CameraDropdown  component and place across the top of the 
form.

5. Select a Checkbox control and place on the form. In the properties, change 
the name of the control to UseTrigger and the caption to read “Use Trigger”.

6. Place a CommandButton on the form. In the properties, change the name of 
the control to VirtualTrigger and the caption to read “Send Virtual Trigger”.
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7. Select the Imageview component and position on the form.

8. Similar to the previous example, enter the following code to initialize an 
ImageConnection, connect it to the MiImageView control and handle the 
OnConnectionReset event to set the initial state of the controls. Also, notice 
that when the OnConnectionReset event is received and the 
iconn.IsConnected is true, then we use the iconn.CommandSend method to 
send the “CONTROL” command to the camera. Otherwise, we disable the 
Checkbox and CommandButton controls.

Option Explicit
Dim WithEvents iconn As ImageConnection

Private Sub Form_Load()
      Set iconn = New ImageConnection
      iconn_OnConnectionReset
End Sub

Private Sub Form_Unload(Cancel As Integer)
      Set iconn = Nothing
End Sub
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Private Sub iconn_OnConnectionReset()
    If iconn.IsConnected Then
        iconn.CommandSend "CONTROL"
    Else
        UseTrigger.Enabled = False
        VirtualTrigger.Enabled = False
    End If
End Sub

9. We want to enable the checkbox and button only after we establish control as 
a result of sending the “CONTROL” command. To do this, select the iconn 
object and select the OnControlStatusChanged event to add an event handler. 
Although this event returns a integer code signifying the status of the 
camera, we can simply check if we now have control by using the 
HaveControl property of the ImageConnection:

Private Sub iconn_OnControlStatusChanged(ByVal newStatus As 
Long)
    UseTrigger.Enabled = iconn.HaveControl
    VirtualTrigger.Enabled = iconn.HaveControl
End Sub

10. To have the checkbox reflect whether the camera is triggered or not, we need 
to do a “Query” of the TRIG command. The two possible states are “TRIG 
C” for continuous and “TRIG T” for triggered. A query consists of sending 
the “TRIG ?” command to see what the current setting is. It is possible to use 
CommandSend to do everything, but we will instead use the Application 
object. This object simplifies querying and changing settings, and is 
particularly useful when the commands are complex and/or you are 
changing more than one setting at a time. Add the following code:

At the top of the module declare the following:

Dim app As New Application
Dim bInUpdateVisuals as boolean

Change the code in the OnConnectionReset event to read:

Private Sub iconn_OnConnectionReset()
    If iconn.IsConnected Then
        app.Query iconn.ASCIIConnection, "TRIG" ‘ <-----add this line
        iconn.CommandSend "CONTROL"
    Else
        UseTrigger.Enabled = False
        VirtualTrigger.Enabled = False
    End If
End Sub
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Notice that the app.Query command requires that you pass an 
MiASCIIConnection object as the first parameter. Use the 
ImageConnection.ASCIIConnection property in this case.

Add a new subroutine to handle updating the checkbox:

Private Sub UpdateVisuals()
    bInUpdateVisuals = True
    Dim bTriggered As Boolean
    bTriggered = app.Setting("TRIG").Params(0) = "T"
    UseTrigger.Value = IIf(bTriggered, vbChecked, vbUnchecked)
    VirtualTrigger.Enabled = bTriggered
    bInUpdateVisuals = False
End Sub

There are a couple of things to notice here. The Application object consists 
of a collection of AppSetting objects. You index this collection with the 
name of the setting, in this case “TRIG”. Each AppSetting can have multiple 
parameters, which are indexed using a zero based index. Therefore, the line

bTriggered = app.Setting("TRIG").Params(0) = "T"

is setting the state of the Boolean variable bTriggered, depending on 
whether or not the first parameter is “T”.

Also, we set the global variable bInUpdateVisuals to True at the start and 
False at the end of this subroutine. This is because we are setting the 
checkbox state in this routine which will, in turn, cause an event to happen. 
As you will see, we don’t really want to handle the event in this case, since 
the event will call UpdateVisuals and we’d be stuck in an infinite recursion. 
We will use this global boolean to prevent this.

Now we can handle the checkbox Click event:

Private Sub UseTrigger_Click()
    If bInUpdateVisuals Then Exit Sub
    If UseTrigger.Value = vbChecked Then
        app.Setting("TRIG").SetParam 0, "T"
    Else
        app.Setting("TRIG").SetParam 0, "C"
    End If
    app.WriteSettings iconn.ASCIIConnection
    UpdateVisuals
End Sub

The first line exits immediately if we find we got here via UpdateVisuals to 
prevent recursion.
2-18 HawkEye 1500 Series Reference & Programmers Manual Rev 2.2.1, Jul. 2006



Example 4 – Controlling the HawkEye™ 1500

R
ea

d
R

u
n

n
er

 
P

ro
g

ra
m

m
in

g
 

2

Next, you can see how the SetParam method is used; in this case, we are 
setting the first parameter to either “T” or “C”, depending on the state of the 
check box.

To send all the changed settings back to the camera (in this case, there’s only 
one), we use the WriteSettings method of the Application object. Again, you 
need to provide an MiASCIIConnection, so use the ASCIIConnection 
property of iconn.

We then call UpdateVisuals to make sure the checkbox reflects the current 
state of the “TRIG” command.

11. Lastly, to send the virtual trigger command, handle the Click event for the 
VirtualTrigger button:

Private Sub VirtualTrigger_Click()
    ' send a virtual trigger command
    iconn.CommandSend "VT 2"
End Sub

12. You’re done. Run the project.
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Example 5 – Image Overlay Graphics and Auto Connection
This example will illustrate how to make a custom graphic overlay. It will also 
demonstrate how to automatically connect to a camera without using the 
CameraDropdown control as in previous examples:

1. Establish an image connection to a known HawkEye™ 1500 by name.

2. Display an image, but disable the normal overlay graphics and replace them 
with custom graphics consisting of:

– A crosshair display

– Decode string and pass/fail counters at the top of the image

This project will begin in standard fashion:

1. Create a new “Standard EXE” project.

2. Select Project->References… and check the Siemens HawkEye™ Reader 
Object Type Library (MIOBJ.DLL).

3. Select Project->Components… and check BOTH the Siemens 
ReadRunner ActiveX Library (RRKIT.OCX) and the Siemens HawkEye™ 
Reader ActiveX Library (MIOBJUI.DLL).

4. Select the MiImageView  component and position on the form.

5. Select the MiImageView1control and, in its properties, set the 
ShowCycleGraphics, ShowCycleText and ShowOverlay properties to False. 
In this example, we will take over all drawing ourselves.
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The complete code for this example follows:

Option Explicit
Const MY_CAMERA = "jdzoffice" ‘ <-------- replace with your camera name

Const TRANSPARENT = 1
Const OPAQUE = 2

Implements MiDrawObj ‘ <---------- makes this form a DrawObj

Dim WithEvents coord As MiCoordinator
Dim WithEvents iconn As ImageConnection

Dim saveReport As MiCycleReport
Dim myFont As New StdFont

Private Sub Form_Load()
    Set coord = New MiCoordinator
    Set iconn = New ImageConnection
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    coord.ClearDevices
    With myFont
        .Size = 7
        .Name = "Arial"
    End With
    MiImageView1.DrawObjAdd Me, "overlay"
    iconn_OnConnectionReset
End Sub

Private Sub Form_Unload(Cancel As Integer)
    coord.DeviceFocusSet ""
    Set coord = Nothing
    Set iconn = Nothing
    Set saveReport = Nothing
End Sub

Private Sub iconn_OnConnectionReset()
    If Not iconn.IsConnected Then
        MiImageView1.ClearRecords
    End If
End Sub

Private Sub coord_OnDeviceDiscovered(ByVal newDevice As 
MIOBJLib.IMiDevice)

    If newDevice.Name = MY_CAMERA then
        coord.DeviceFocusSet MY_CAMERA

    End If
End Sub

Private Sub iconn_OnNewRecord(ByVal objReport As 
MIOBJLib.IMiCycleReport)
    MiImageView1.NewRecord objReport
    Set saveReport = objReport
End Sub

Private Sub Form_Resize()
    On Error Resume Next
    MiImageView1.Move 0, 0, ScaleWidth, ScaleHeight
End Sub

Private Sub MiDrawObj_Draw(ByVal midc As MIOBJUILibCtl.IMiDC)
    If iconn.IsConnected Then
        If Not saveReport Is Nothing Then
            midc.SetBkMode OPAQUE
            midc.SetFont myFont
            midc.SetTextColor vbCyan
            Dim s As String
            With saveReport
                s = saveReport.ReportDecode.DecodeDataFormatted
                s = Replace(s, vbCrLf, "")
                s = s & " Passed = " & .CountDecodes
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                s = s & " Failed = " & .CountDecodeFail
            End With
            midc.TextOut 8, 6, s

        End If
        midc.SetBkMode TRANSPARENT
        midc.SetPen 1, 1, vbRed
        midc.MoveTo 320, 0
        midc.LineTo 320, 480
        midc.MoveTo 0, 240
        midc.LineTo 640, 240
   End If
End Sub

Now, let’s walk through this project step by step.

1. The MY_CAMERA constant at the top should be changed to be the network 
name of your camera. Instead of using the CameraDropdown, we will 
connect to this camera as soon as it’s discovered on the network.

2. Custom overlay graphics are accomplished by creating an object that 
implements the MiDrawObj interface. This can be a separate class module, 
but can also be a form, so we’ll just use our main form for this. Notice the 
Implements MiDrawObj statement towards the top of the code. As a result of 
this statement, you will be required to fill in a MiDrawObj_Draw subroutine. 
We’ll get to that soon.

3. This project uses a MiCoordinator as well as a MiImageConnection. These 
are declared at the top, allocated in Form_Load, and released in 
Form_Unload.

4. We also need a place to temporally stash a MiCycleReport, so we declare a 
variable of that type called saveReport. It will be set in the OnNewRecord 
event handler. It needs to be released in Form_Unload. 

5. For this example, we will need to define a font, so we declare a new StdFont 
called myFont. In Form_Load, we set the font’s Name and Size.

6. The MiCoordinator has a list of devices on the network. Although the device 
we’re interested in may already be in the list, it also may not yet be 
discovered. To avoid unnecessary complication, we start off by clearing this 
list in Form_Load by calling the ClearDevices method. This ensures that, as 
each device is discovered, we will get an OnDeviceDiscovered event. In the 
OnDeviceDiscovered event handler, we check to see if the name of the 
device just discovered matches the one we’re looking for and, if so, calls 
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DeviceFocusSet with the device name. This, in turn, will cause our 
ImageConnection to connect.

7. In the OnNewRecord event handler, we call the MiImageView1.NewRecord 
method to show the image as normal. We will also stash away a reference to 
the MiCycleReport by setting our saveReport variable to it.

8. To make the MiImageView control aware that we want to overlay our own 
graphics, notice the line MiImageView1.DrawObjAdd Me, “overlay” in 
Form_Load. This instructs the MiImageView control that we are adding a 
custom drawing object, which happens to be this form (using the VB 
keyword ”Me”). The second parameter is a symbolic name given to the 
drawing object, which you will need if you want to be able to remove it later. 
You can call it anything you want, so here we’re calling it “overlay”.

9. The Implements MiDrawObj statement at the beginning means we are now 
required to implement the MiDrawObj_Draw method. This method will get 
called every time the MiImageDisplay is updated. The parameter supplied to 
the method gives us a very useful object of type MiDC. This object provides 
methods for drawing lines, rectangles, ellipses, and text. You can set pen 
styles, fonts, etc. And, most importantly, it scales all graphics for you so you 
just draw in image coordinates. In this example, a crosshair is drawn and text 
string is displayed with the decode string and some counters.

Siemens HawkEye™ Reader Object Type Library
MiObj.DLL - C++ low-level connection library.

MiCoordinator
Co-ordinates objects within a single process.

Methods

• Sub DeviceFocusSet(ByVal bszName As String, Optional ByVal bszUser As 
String=, Optional ByVal bszPassword As String=) — DeviceFocusSet and 
connect for control if user and pwd given.

• Function DeviceFocusGet() As IMiDevice — Returns the device object that 
currently has the focus.
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• Property Get Devices() As IMiDeviceCollection — Returns the set of 

known devices.

• Sub ClearDevices — Clears the device list.

• Sub BroadcastMessage(bstrSender As String, bstrMsg As String, bstrParam 
As String) — Broadcast a message to other users of MiCoordinator.

Events

• OnDeviceFocus(ByVal objDevice As IMiDevice) — Sent when a named 
device has been given the focus.

• OnDeviceDiscovered(ByVal newDevice As IMiDevice) — Sent when a new 
device has been discovered.

• OnDeviceStatusChanged(ByVal device As IMiDevice, ByVal newStatus As 
EOnlineStatus) — Fired when a network device status changes.

• OnDeviceListCleared() — Fired when the device list has been cleared.

• OnDeviceListCleared() — Fired when the device list has been cleared using 
the ClearDevices method.

• OnBroadcastMessage(bstrSender As String, bstrMsg As String, bstrParam 
As String) — Fired when a MiCoordinator user calls BroadcastMessage.

MiDevice
Represents a camera device.

Methods

• Property Get Name() As String — Name of the device.

• Property Let Name(RHS As String) — Name of the device.

• Property Get NetworkName() As String — NetworkName of the device.

• Property Let NetworkName(RHS As String) — NetworkName of the 
device.

• Property Get ASCIIConnection() As IMiASCIIConnection — Returns/sets 
embedded ASCIIConnection object.
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• Property Let ASCIIConnection(RHS As IMiASCIIConnection) — 
Returns/sets embedded ASCIIConnection object.

• Property Get OnlineStatus() As EOnlineStatus — Returns the current status 
of the device.

• Property Let OnlineStatus(RHS As EOnlineStatus) — Returns the current 
status of the device.

• Property Get IPAddress() As String — Sets/returns the IP address of the 
device.

• Property Let IPAddress(RHS As String) — Sets/returns the IP address of the 
device.

• Property Get TimeStamp() As Long — Determines device inactivity.

• Property Let TimeStamp(RHS As Long) — determines device inactivity.

• Sub RefreshInfo — Queries device for current information. Updates 
accordingly.

• Sub ConnectASCII(ByVal bszUserName As String, ByVal bszPassword As 
String) — Connects an ASCII connection to the device.

• Sub DisconnectAll — Disconnects all connections to the device.

• Sub ConnectReports(ByVal bszUserName As String, ByVal bszPassword As 
String) — Connects to the device for reports, establishes the 
ReportConnection object.

• Sub ConnectImages(ByVal bszUserName As String, ByVal bszPassword As 
String) — Connects to the device for images and decode data (lossy), 
establishes the ImageConnection object.

• Property Get ReportConnection() As IMiReportConnection — Returns/sets 
the report connection for the device.

• Property Let ReportConnection(RHS As IMiReportConnection) — 
Returns/sets the report connection for the device.

• Property Get ImageConnection() As IMiImageConnection — Returns/sets 
the ImageConnection for this device.
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• Property Let ImageConnection(RHS As IMiImageConnection) — 

Returns/sets the ImageConnection for this device.

• Property Get CountCycle() As Long — Returns the cycle count from a 
RefreshInfo call.

• Property Get CountPassed() As Long — Returns the Passed count from a 
RefreshInfo call.

• Property Get CountAlarms() As Long — Returns the Alarm count from a 
RefreshInfo call.

• Property Get NumNetworkConnections() As Long — Returns number of 
active network connections to the device.

• Property Get NameOfController() As String — Returns the name or IP 
address of the network connection controlling the device.

• Property Get HaveControl() As Boolean — Returns True if this computer 
has control of the device.

• Property Get DirtyBits() As Long — Returns state of the dirty bits for the 
device.

• Sub FilesSend(ByVal whichDrv As ERamDrive, ByVal fileOrList As 
Variant) — Send specific set of files to a particular RAM drive on the 
camera.

• Property Get SoftwareVersion() As String — Returns version of the software 
on the device.

Events

• OnConnected(ByVal connObj As IMiConnection) — Sent when a specific 
connection object connects.

• OnDisconnected(ByVal connObj As IMiConnection) — Sent when a 
specific connection object disconnects.

• OnOnlineStatusChanged(ByVal newStatus As EOnlineStatus) — Sent when 
online/offline status changes.

• Function OnControlStatusChanged(ByVal newStatus As EControlStatus) — 
Sent when taking or releasing control of device.
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MiASCIIConnection
A device connection that sends and receives ASCII data. This is the only type of 
connection supported for serial ports.

Methods

• Sub Disconnect — Disconnects the connection.

• Sub Connect(ByVal bszName As String) — Connects to the given device.

• Property Get Connected() As Boolean — Returns True if connected.

• Sub Reconnect — Reconnects the device.

• Sub CommandSend(ByVal bszCmd As String, Optional ByVal lTimeout As 
Long=10000) — Sends a command over the connection, waits up to 
lTimeout msecs for result.

• Property Get Name() As String — Name of the connection (read-only).

• Sub ImageUploadStart(Optional ByVal nCompression As Long=0, Optional 
ByVal useTriggers As Boolean=False, Optional ByVal doDecode As 
Boolean=True, Optional ByVal useAutoPhoto As Boolean=True, Optional 
ByVal lGain As Long=250, Optional ByVal lExposure As Long=10500) — 
Starts an image upload using the given settings.

• Sub ImageUploadAbort — Aborts an image upload already in progress.

• Function LineRead(Optional ByVal nTimeout As Long=1000) As String — 
Reads a line from the connection - blocking until received.

• Property Get LineQueue() As IMiLineQueue — Property LineQueue.

MiReportConnection
A non-lossy device connection which sends CycleReports w/o images.

Methods

• Sub Disconnect — Disconnects the connection.

• Sub Connect(ByVal bszName As String) — Connects to the given device.

• Property Get Connected() As Boolean — Returns True if connected.
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• Sub Reconnect — Reconnects the device.

MiImageConnection
A lossy device connection which sends CycleReports containing images.

Methods

• Sub Disconnect — Disconnects the connection.

• Sub Connect(ByVal bszName As String) — Connects to the given device.

• Property Get Connected() As Boolean — Returns True if connected.

• Sub Reconnect — Reconnects the device.

• Property Get FreezeMode() As EFreezeMode — Returns the current freeze 
mode.

• Property Get FailFlags() As EFailFlags — Returns the current fail flags that 
qualify Failed and Freeze-Next-Failed modes.

• Sub FreezeModeSet(ByVal newMode As EFreezeMode, Optional ByVal 
newFlags As ENewFlags=-1) — Sets the freeze mode for the connection.

• Property Get MaxRate() As Long — Returns/sets the maximum images per 
second transferred by the camera on this connection.

• Property Let MaxRate(RHS As Long) — Returns/sets the maximum images 
per second transferred by the camera on this connection.

• Sub LiveStart — Starts live video on the camera, associated 
ASCIIConnection must be in control.

• Sub LiveStop — Stops live video on the camera.

• Property Get LiveEnabled() As Boolean — Returns True if live mode is 
enabled.

Connection Events
All connection types fire the following events.
Rev 2.2.1, Jul. 2006 HawkEye 1500 Series Reference & Programmers Manual 2-29



Chapter 2 ReadRunner Programming Reference
Events

• OnNewLine(ByVal bszLine As String) — Fired when a new line is received.

• OnNewRecord(ByVal objReport As IMiCycleReport) — Fired when a new 
data record is received.

• OnDataTransferStarted() — Event fired when a new data record upload has 
been started.

• OnDataTransferRetry() — Event fired when a block read failed and is being 
retried.

• OnDataTransferAborted() — Event fired when an record transfer upload is 
aborted.

• OnDataTransferPercentComplete(ByVal nPercent As Integer) — Event 
fired to indicate percent complete on the data transfer.

• OnConnected() — Event fired when connected.

• OnDisconnected() — Event fired when disconnected.

• OnSentLine(ByVal bszLine As String) — Fired when a line is sent through 
the connection.

• OnSendingLine(ByVal bszCommand As String) — Fires this event before 
sending a line.

• OnSentCommand(ByVal bszCommand As String) — Fired after a command 
has been sent and processed.

• OnPartQueueReceived(ByVal objColl As ImiCycleReportCollection) — 
Fired when a new part queue collection is received.

• OnConnectionDropped(ByVal errCode , ByVal bszDescription As String) — 
Fired when a connection is dropped ungracefully.

Siemens HawkEye™ Reader ActiveX Type Library
MiObjUI.DLL - C++ low-level GUI library
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MiTimeplot

Plots multiple variables which are linked in time.

Methods

• Function AddTrace(ByVal bstrName As String, ByVal color As ULong, 
Optional ByVal bDigital As Long=0) As Long — Adds a trace.

• Sub StartNewData — Start of a data set event.

• Sub EndNewData — End of a data set event.

• Sub NewData(ByVal idTrace As Long, ByVal value As Double) — Record 
new data for specified trace.

• Sub Refresh — Redraw control.

• Function AddYAxis(ByVal bstrName As String, ByVal color As ULong, 
ByVal val As Double, Optional ByVal style As Long=2) As Long — Adds a 
Y axis.

• Property Let BackColor(RHS As ULong) — Sets the background color of 
the control.

• Sub SetYRange(ByVal minPlot As Double, ByVal maxPlot As Double) — 
Sets the y range for the overall plot.

• Sub SetXStep(ByVal xStep As Long) — Sets the number of pixels between 
plotted points.

• Property Let LegendColor(RHS As ULong) — Background color of the 
legend area.

• Property Let LegendTextColor(RHS As ULong) — Text color of the legend 
area.

• Sub NewEvent(ByVal color As ULong, ByVal style As Long, ByVal info As 
String) — Add a event which appears as a vertical line in time.

• Sub NewState(ByVal idTrace As Long, ByVal bState As Long) — Add a 
digital event state.

• Sub SetBias(ByVal idTrace As Long, ByVal bias As Double) — Set trace 
bias.
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• Sub SetScale(ByVal idTrace As Long, ByVal Scale As Double) — Set trace 
scale.

• Function AddLabel(ByVal x As Double, ByVal y As Double, ByVal caption 
As String, ByVal fontsize As Long, ByVal TextColor As ULong, ByVal 
BackColor As ULong, Optional ByVal bBold As Long=0, Optional ByVal 
bOpaque As Long=1) As Long — Add a text label.

• Sub SetItemVisible(ByVal id As Long, ByVal bVisible As Boolean) — Set 
visibility of specified item.

• Function IsItemVisible(ByVal id As Long) As Boolean — Check visibility 
of specified item.

MiImageView
Display images associated with CycleReports with optional Filmstrip capability 
an user defined drawing objects.

Methods

• Sub NewRecord(ByVal objCycleReport As IMiCycleReport) — Display 
image associated with objCycleReport. If in filmstrip mode, add it to stored 
records.

• Sub ClearRecords — Clear all records - which also clears the display.

• Sub Refresh — Refresh control graphics.

• Property Get FilmstripMode() As Boolean — Get filmstrip mode.

• Property Let FilmstripMode(RHS As Boolean) — Set filmstrip mode.

• Property Get ShowOverlay() As Boolean — Get overlay graphic visibility.

• Property Let ShowOverlay(RHS As Boolean) — Set overlay graphics 
visibility.

• Sub DrawObjAdd(ByVal objDraw As IMiDrawObj, Optional ByVal key As 
String=) — Add a user defined drawing object.

• Sub DrawObjRemove(ByVal key As String) — Remove a user defined 
drawing object.

• Sub DrawObjClear — Remove all user defined drawing objects.
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• Property Get ShowCycleGraphics() As Boolean — Get visibility of cycle 

graphics.

• Property Let ShowCycleGraphics(RHS As Boolean) — Set visibility of 
cycle graphics.

• Function CycleReportFromMousePos(ByVal xPos As Integer, ByVal yPos 
As Integer) As IMiCycleReport — For filmstrip mode, given a mouse 
position returns the corresponding CycleReport.

• Sub SetFilmstripRecords(ByVal objCollection As 
IMiCycleReportCollection) — Sets all filmstrip records at once given a 
collection of CycleReports.

Events

• OnMouseMove(ByVal xPos As Integer, ByVal yPos As Integer, ByVal flags 
As Integer) — Event fired on Mouse Move.

• OnLButtonDown(ByVal xPos As Integer, ByVal yPos As Integer, ByVal 
flags As Integer) — Event fired on Mouse Left Button Down.

• OnLButtonUp(ByVal xPos As Integer, ByVal yPos As Integer, ByVal flags 
As Integer) — Event fired on Mouse Left Button Up.

• OnLButtonDblClk(ByVal xPos As Integer, ByVal yPos As Integer, ByVal 
flags As Integer) — Event fired on Mouse Left Double Click.

• OnRButtonDown(ByVal xPos As Integer, ByVal yPos As Integer, ByVal 
flags As Integer) — Event fired on Mouse Right Button Down.

• OnRButtonUp(ByVal xPos As Integer, ByVal yPos As Integer, ByVal flags 
As Integer) — Event fired on Mouse Right Button Up.

IMiDrawObj
Implement this interface to draw custom graphics in MiImageView.

Methods

Sub Draw(ByVal midc As IMiDC)
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MiDC
A graphics “Device Context” for drawing within user defined drawing objects.

Methods

• Property Get hDC() As Long

• Property Let hDC(RHS As Long)

• Sub MoveTo(ByVal x As Double, ByVal y As Double)

• Sub LineTo(ByVal x As Double, ByVal y As Double)

• Sub SetPen(ByVal style As Integer, ByVal width As Integer, ByVal color As 
ULong)

• Sub SetBkMode(ByVal bkMode As Integer)

• Sub SetBkColor(ByVal color As ULong)

• Sub SetTextColor(ByVal color As ULong)

• Sub Rectangle(ByVal left As Double, ByVal top As Double, ByVal right As 
Double, ByVal bottom As Double)

• Property Get Scale() As Double

• Property Let Scale(RHS As Double)

• Property Get XOffset() As Double

• Property Let XOffset(RHS As Double)

• Property Get YOffset() As Double

• Property Let YOffset(RHS As Double)

• Sub ScreenToPixel(ByVal x As Double, ByVal y As Double)

• Sub PixelToScreen(ByVal x As Double, ByVal y As Double)

• Sub DrawHandle(ByVal x As Double, ByVal y As Double, ByVal color As 
ULong, Optional ByVal flags As Long=0)

• Sub SetSolidBrush(ByVal color As ULong)
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• Sub SetNullBrush()

• Sub Ellipse(leftRect As Double, topRect As Double, rightRect As Double, 
bottomRect As Double)

• Sub SetFont(pFont As IFontDisp)

• Sub TextOut(x As Double, y As Double, bstrText As String)

Pen Style Constants for SetPen

• Const PS_SOLID = 0

• Const PS_DASH = 1

• Const PS_DOT = 2

• Const PS_DASHDOT = 3

• Const PS_DASHDOTDOT = 4

• Const PS_NULL = 5

IMiDrawHandles
Implement this interface to make custom graphics “dragable.”

Methods

• Sub GetHandle(ByVal index As Long, ByVal x As Double, ByVal y As 
Double, ByVal flags As Long)

• Sub MoveHandleTo(ByVal index As Long, ByVal x As Double, ByVal y As 
Double)

• Sub MoveRelative(ByVal x As Double, ByVal y As Double)

• Property Get NumHandles() As Long

• Sub DrawHandle(ByVal midcIn As IMiDC, ByVal index As Long)

• Function PointIsInside(ByVal x As Double, ByVal y As Double) As Boolean
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